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LESSON 1 -  
GETTING STARTED  

In this lesson, you will learn how to: 

• Start Access  

• Open an existing database  

• Use menu commands  

• Display and hide toolbars  

• Change menu and toolbar options  

• Use database objects  

• Use the Database window  

• Select object types  

• Open a database object  

• Exit Access  
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STARTING ACCESS 

 Discussion 
A database is any collection of information organized into a group. The information 
should be organized in a way that allows for easy retrieval. For example, a telephone 
book is a non-computerized database of information. It is organized in alphabetical 
order and includes information such as names, addresses, and telephone numbers. 
Other examples of non-computerized databases include address books and inventory 
lists. 
 
Electronic databases can be maintained on a computer. Computerized databases allow 
you to manipulate large amounts of data quickly and easily. They simplify tasks such 
as searching for specific data, organizing and sorting data, and making corrections or 
changes to data. 
 
In Access, the database information is stored in data tables. Every data table has a 
structure that provides for the collection, organization, storage, and retrieval of data. 
These tables of information are contained in a database file. Each database file can 
have numerous data tables. 
 
A data table consists of fields and records. Fields are categories of information. For 
example, in an address table, you may maintain names, addresses, cities, states, and 
zip codes. Each of these categories is a field in the address database. 
 
A set of fields that contains data for a single entry is called a record. For example, 
Charles Hardy, 1234 Main St., Bridgeville, NY, 11012 is a record in the address table. 
Each piece of information in the record fits into a field and is referred to as a field 
value. NY is the field value for the State field in this particular record. An address 
table would most likely consist of a number of records, with each record containing 
values in the appropriate fields. 
 
Access is a relational database application. A relational database contains a large 
amount of data that is split into numerous tables. Each table is then smaller, more 
manageable, and, in turn, more efficient. In a relational database, each table should 
represent one subject, such as Customer, Order, or Items. These tables can then be 
joined together to make them related. When tables are related, you can access 
information from any of the fields in the related tables. Therefore, your reports, forms, 
and queries can be based on information from any of the related data tables. 
 
In addition to extensive built-in help, the Microsoft Office Assistant is available to 
offer tips and hints for using Access more efficiently. The Office Assistant, a context-
sensitive Help feature, may appear when you start Access. You can adjust the 
capabilities of the Office Assistant as well as choose not to have the Office Assistant 
appear, if desired. 
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Additionally, Office on the Web provides an on-line link to resources you can use to 
help you create better databases. For example, you can use Office on the Web to link 
to Internet sites where you can access technical resources and free product 
enhancements. 
 
Microsoft Access 2000 is designed to run under the Windows operating system. By 
default, Windows creates a startup command for Access on the Programs submenu 
which is accessed from the Start menu. Your system may be different, depending on 
how Access was installed or customized. 
 
When you start Access, the Microsoft Access dialog box opens. Options available in 
this dialog box include creating a blank database, using the Database Wizard to create 
a database, or opening an existing database. At the bottom of the dialog box is a list of 
recently used database files from which you can open a database file quickly and 
easily. If you choose the More Files option in the Microsoft Access dialog box, the 
Open dialog box opens, allowing you to select a database file from a desired location. 

 
The Microsoft Access dialog box 

 
  

 
You can create a shortcut to start Access on the Windows 
desktop. 

  

 
The first time you open the Microsoft Access dialog box after 
installation, the list of recently used files and the More Files 
option will not be available at the bottom of the dialog box 
because no previous files have been used. 
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 Steps 

1. Select the Start button on the taskbar. 

2. Point to Programs. 

3. Select Microsoft Access. 

 

OPENING AN EXISTING DATABASE 

 Discussion 
An Access database is a collection of information organized into a number of objects 
including tables, queries, forms, reports, pages, macros, and modules. 
 
When you want to work with an Access database, you must first load the database into 
memory. This process enables you to open all the tables or other objects within that 
database. You may only open one database at a time. 
 
You can open a database using the Microsoft Access dialog box. You can choose a 
file from the list of recently used files, or you can select the More Files option to 
access the Open dialog box. If the Microsoft Access dialog box is not available, you 
can open a database directly from the Open dialog box. 

 
The Open dialog box 
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You can also open a database directly from the Open dialog 
box by clicking the Open button or by selecting the File menu 
and then selecting the Open command. 

  

 
Access lists the names of recently used database files at the 
bottom of the File menu. You can quickly open any one of 
these files by selecting it from the menu. 

  
 

 Steps 

1. Start Access. 

2. Select the Open an existing file option. 

3. Select OK. 

4. Select the Look in list. 

5. Select the drive where the database is stored. 

6. Select the folder where the database is stored. 

7. Select the name of the database you want to open. 

8. Select Open. 

 

USING MENU COMMANDS 

 Discussion 
The menu bar, located under the application title bar, provides access to all the 
features of Access. Each menu contains commands grouped by function. When you 
select an item on the menu bar, a list of corresponding commands appears, from 
which you can select the desired command. Some menu commands are dimmed, 
which indicates that the command is not available for the current task. 
 
Each menu appears in two stages, a short menu and a full menu. When you first select 
a menu, the short menu appears with the most frequently used commands. 
 
If a command does not appear on the short menu, you can click the double arrows that 
appear at the bottom of the menu. This action expands the short menu to display the 
full menu with all available commands. Once you have expanded a menu, all menus 
are expanded until you choose a command or perform an action. Other ways to 
expand a menu include double-clicking the menu name in the menu bar, or hovering 
over the double arrows or menu name with the mouse pointer. 
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As soon as you select a command from the full menu, it is added to the short menu. In 
this way, your short menus are updated with the most frequently used commands. 
Commands stay on the short menu until you stop using them for a while or reset your 
data usage. 
 
When a menu command is followed by an ellipsis (...), selecting it opens a dialog box 
in which additional information is entered. A menu command that displays a right-
pointing triangle indicates a submenu. When you point to this command, a submenu 
cascades to the right. 
 
In addition to the standard menus on the menu bar, Access contains shortcut menus 
that may be accessed by right-clicking an area or an object, such as a toolbar. Shortcut 
menus contain commonly used commands and are context-sensitive. Therefore, the 
options available on the shortcut menu vary, depending on the area of the window or 
the object selected. 
 

  

 
You can also execute menu commands using key 
combinations. To display a menu, press the [Alt] key and the 
underlined letter of the menu name. You can then press the 
underlined letter of the desired command to perform the 
action. 

  

 
You can choose to show full menus by selecting the Tools 
menu and then selecting the Customize command. On the 
Options page in the Customize dialog box, deselect the 
Menus show recently used commands first option. Selecting 
the Reset my usage data button and then selecting the Yes 
button to confirm, removes automatically added full menu 
commands from short menus. 

  

 
Some Office 2000 components may be available on an Install 
on First Use basis. This term means that although the 
component appears on the menu, it is not actually installed 
until the first time you use it. Office 2000 then prompts you to 
install the component and installs it from the original 
installation source to your local hard drive. 

  
 

 Steps 

1. Click the desired menu. 

2. To display the full menu, click the double arrow at the bottom of the 
short menu. 

3. Click the desired command. 



Creating Tables Using Access 2000 Lesson 1 - Getting Started 

US Senate Office of Education and Training Page 7
 

 

DISPLAYING AND HIDING TOOLBARS 

 Discussion 
Toolbars provide shortcuts to menu commands. Each Access toolbar is composed of 
buttons and pull-down lists. Each button executes a specific menu command. 
 
When Access starts, the Database toolbar appears by default on the same row under 
the menu bar. The Database toolbar contains buttons used for many general Access 
functions. You can also display the Web toolbar, which provides buttons you can use 
for creating web pages.  
 
In addition to the default toolbars you can select in Access, task specific toolbars 
appear when you are working in the various views. For example, when you open a 
Table object type, the Clipboard, Formatting (Datasheet), Table Datasheet, and 
Web toolbars are available. 
 
You can choose to display one or more toolbars at any given time, or you can hide all 
the toolbars to create a larger working area. 
 
Toolbars may be displayed as either “docked” or floating toolbars. A docked toolbar 
appears at the edges of the window, whereas floating toolbars may be moved to any 
location on the screen. You can also change the size and shape of a floating toolbar. 
These options provide flexibility when you need to display several toolbars at once or 
need to see all the available buttons on a docked toolbar. 
 
When you point to a button on a toolbar, the name for its function appears. This 
description is referred to as a toolbar ScreenTip. Even if a toolbar button is dimmed 
(because it is not available for the current task), the ScreenTip still appears when you 
point to the button. 
 
In addition to moving a toolbar, you can also use the More Buttons button at the end 
of certain toolbars to see any hidden buttons that do not fit on the docked toolbar. 
 

  

 
You can customize toolbars by adding or removing buttons. 

  

 
You can also display and hide toolbars by selecting the desired 
toolbar on the Toolbars page in the Customize dialog box or 
by right-clicking the menu bar or any toolbar and selecting or 
deselecting any of the toolbars. A checkmark next to the name 
of a toolbar indicates that it is displayed. 
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If you hide all the toolbars, you can display them by selecting 
the View menu, pointing to the Toolbars command, and 
selecting the desired toolbar command, or by right-clicking the 
menu bar and selecting the desired toolbar command. 

  
 

 Steps 

1. Select the View menu. 

2. Point to the Toolbars command. 

3. Select the command for the toolbar you want to display or hide. 

 

CHANGING MENU AND TOOLBAR OPTIONS 

 Discussion 
You can change menu and toolbar options in order to adjust the behavior of these 
objects. The Options page in the Customize dialog box allows you to select menu and 
toolbar preferences. For example, if you prefer to see full menus, you can disable the 
option to show recently used commands first. You can also reset any data usage 
changes that have occurred as a result of using the menus and toolbars. 
 

  

 
The Reset my usage data option only affects Access. All 
other options affect all Office applications. 

  
 

 Steps 

1. Select the Tools menu. 

2. Select the Customize command. 

3. Select the Options tab. 

4. To restore toolbars and menus to the default, select Reset my usage 
data. 

5. Select Yes to reset the toolbar and menu. 

6. Change any additional options as desired. 
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7. Select Close. 

 

USING DATABASE OBJECTS 

 Discussion 
An Access database file can contain objects such as tables, queries, forms, reports, 
pages, macros, and modules. You can select these database objects and manipulate 
them as a unit. Database objects are created to input, edit, retrieve, display, and print 
data. You can include up to seven different object types in an Access database. A 
description of each of these object types is listed in the following table: 

 
Object Type Object Purpose 

Table This object type defines the structure of an Access 
database. Tables display multiple records in rows and 
columns. Information in these records can be entered, 
edited, stored, and retrieved. 

Query A way of requesting selected information from a 
table. When you run a query, a selected set of records, 
called the Recordset, appears. You can then edit or 
print the Recordset. 

Form A screen display you can create to show selected 
fields from records. Forms allow you to enter, view, 
and edit data. You can use a form as an alternative to 
displaying data in rows and columns. 

Report A design for printed data. Reports can include lists 
and mailing labels as well as database reports. 
Reports can also perform math and calculate 
summaries. 

Page A data access Web page used for viewing and 
working with Microsoft Access databases over the 
Internet or an intranet. 

Macro A stored set of Access commands that can be repeated 
as a unit to automate database functions. 

Module This object type stores Visual Basic for Applications 
Edition programming code that can further customize 
and enhance database functions. 

 
When you open a database, all objects that exist in the database are grouped under one 
of the object types listed in the preceding table. These object types, along with their 
corresponding objects, appear in the Database window. 
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USING THE DATABASE WINDOW 

 Discussion 
When you open a database, the Database window opens within the Access application 
window. The Database window contains a title bar, a Database window toolbar across 
the top, an Objects and Groups bar on the left side of the window, and a list area in 
the right side of the window. The Objects bar contains the various object types that 
may appear in an Access database: Tables, Queries, Forms, Reports, Pages, 
Macros, and Modules. The Groups bar contains a Favorites group folder to which 
you can add new group folders. You can also use the Groups bar to view your groups, 
which can contain shortcuts to database objects. 
 
When one of the object types is selected, all objects (if any) associated with that 
selection type appear in an object list. In addition, new object shortcuts for the type of 
object selected appear in the right side of the window. These shortcuts enable you to 
create new objects, such as tables, queries, forms, and reports in Design view or by 
using a wizard. 

 
The Database window 
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SELECTING OBJECT TYPES 

 Discussion 
When you open a database, the Database window automatically opens. This window 
contains an Objects bar down the left side of the window and a list area on the right 
side of the window. The Objects bar displays the object types that can be associated 
with the open database. When an object type is selected, all objects associated with 
the selection appear in a list on the right side of the window. For example, selecting 
the Queries object type displays all the queries objects for that particular database. 
Selecting the Forms object type displays all the forms objects for that particular 
database. 
 

  

 
You can also use the [Ctrl+Tab] key combination to select 
different object types. 

  
 

 Steps 

1. Open the desired database. 

2. Click the desired object type in the Objects bar. 

 

OPENING A DATABASE OBJECT 

 Discussion 
You can open a database object to view the data contained within the object. The view 
in which the data appears depends on the type of object you open. Tables and queries 
appear in Datasheet view. Forms appear in Form view. Reports display the data in 
Print Preview. Macros and modules run the programs attached to the object. 
 

  

 
You can also open an object by double-clicking its name in the 
list area on the right side of the Database window. 
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 Steps 

1. Open the desired database. 

2. Display the appropriate object type list. 

3. Click the name of the object you want to open. 

4. Select the Open button  on the Database window 
toolbar. 

 

EXITING ACCESS 

 Discussion 
In order to be efficient, you should close any objects you are not using. You can have 
several objects open at once, but multiple objects use more system resources. Changes 
to databases are saved automatically when you close the Database window. 
 
In addition, when you have finished using Access, you should exit the application 
properly, since Access performs necessary housekeeping before it closes. 
 

  

 
You can also close an object or database by clicking the Close 
button on the desired window title bar. 

  

 
When you make a change to database objects, you are 
prompted to save the changes before you exit. 

  
 

 Steps 

1. Select the File menu. 

2. Select the Exit command. 

 



 

 

LESSON 2 -  
CREATING TABLES  

In this lesson, you will learn how to: 

• Create a new database  

• Design tables  

• Create a table in Design view  

• Use Design view  

• Add field names  

• Assign data types  

• Add a field description  

• Set a primary key  

• Save a new table  

• Use the Table Wizard  



Lesson 2 - Creating Tables Creating Tables Using Access 2000 

Page 14 US Senate Office of Education and Training
 

CREATING A NEW DATABASE 

 Discussion 
When you create a database in Access, you are creating a container for the tables, 
forms, queries, reports, and other database objects. If you create a new database, you 
must then create your own tables, queries, and other objects. To save time, you can 
use the Database Wizard to create a database. The Database Wizard contains several 
business and personal database templates. If you choose one of these templates, 
Access creates not only the database, but also the tables, queries, and other objects. 
 
When you create a database, you must specify the name and location you want to 
assign to the database file in the File New Database dialog box. 
 
After you create the database, the Database window opens. This window contains an 
Objects bar that displays the following object type icons: Tables, Views, Forms, 
Reports, Pages, Macros, and Modules. Created objects can belong to any of these 
categories. The Database window also has buttons that allow you to open objects, 
modify the design of existing objects, and create new objects. 
 

  

 
You can also create a new database by selecting the File menu 
and then selecting the New command. 

  

 
You can also create a new database by selecting the Access 
database wizards, pages, and projects option in the 
Microsoft Access dialog box when you first open Access. You 
can then select the Database icon on the General page in the 
New dialog box. 

  
 

 Steps 

1. Click the New button  on the Database toolbar. 

2. Select the General tab. 

3. Select the Database icon  on the General page. 

4. Select OK. 
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5. Type a name for the database. 

6. Select the Save in list. 

7. Select the drive where you want to store the file. 

8. Select the folder where you want to store the file. 

9. Select Create. 

 

DESIGNING TABLES 

 Discussion 
In Access, there are five steps to designing a table. The first step is to develop a 
thorough understanding of the system, including all the data that will be entered and 
all the reports, statistics, labels, and other output that will be generated. It is helpful to 
gather all the forms you use for input and all the reports generated from the data. This 
process serves two purposes. First, these forms and reports are invaluable when you 
begin detailing exactly what you want stored in each table. Second, once you have 
collected a set of these forms, you can make sure that every item of information on 
your reports is either included in your database or can be derived from data in your 
database. 
 
The second step is to determine how many tables you need and what information you 
will store in each table. Once you have gained an overview of the system, you are 
ready to begin designing your database. The most important decision you must make 
before you begin creating tables is how many tables you want the database to include. 
 
The third step is to design the tables by selecting the fields you want to include, the 
type of data you want to store in each field, and the size of the fields. Once you have 
developed an overview of your application and a list of tables, you can make a 
preliminary list of fields, based on basic categories of information that each table will 
include. You can refine the list by considering the following: if the data will be sorted 
or selected, it should be in a separate field; if the data can be calculated from other 
fields, you do not need to store it in its own field; and, if the table will be linked to 
another table, the tables should contain common fields. 
 
The fourth step is to create the table structures by defining the name, data type, and 
size of the fields. 
 
The fifth and final step is to enter sample data to test your table structures. This step is 
important because it helps you determine whether or not the fields are the correct size 
and if all the necessary fields have been included in the tables. Then, you can modify 
the tables as necessary. 
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CREATING A TABLE IN DESIGN VIEW 

 Discussion 
A table is the basic building block of a database. All the queries, reports, and forms 
use the fields and records from a table as the basis for their output. You must create at 
least one table in the database before you can create any other object. 
 
When you create a new table, the New Table dialog box provides you with several 
options. You can choose to create a table in either Datasheet or Design view, use the 
Table Wizard, import data from another data source, or link to data from another data 
source. Usually, a table is created in Design view, which gives you the most control 
over the design of the database. 

 
The New Table dialog box 

 
  

 
You can also create a new table in Design view by selecting 
the Create table in Design view option in the Tables object 
list in the Database window and then selecting the Open 
button on the Database window toolbar. 
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 Steps 

1. Open the desired database. 

2. Display the Tables objects. 

3. Select the New button  on the Database window toolbar. 

4. Select Design View. 

5. Select OK. 

 

USING DESIGN VIEW 

 Discussion 
The Design view window is split into two panes. The top pane of the window contains 
the design grid. You use the rows and columns to enter field names, data types, and 
field descriptions. The small box to the left of each field name is the row selector. 
When you select a row, a black triangle appears in the row selector for that row to 
indicate the current field. 
 
The bottom pane of the window displays the properties of the selected field. A 
property is a characteristic of a field, such as the number of characters a field can 
contain. Access automatically assigns default field properties you can modify, if 
desired. 
 

  

 
Once you have entered at least one field, you can press the 
[F6] key to move between the panes in the Design view 
window. 

  
 

ADDING FIELD NAMES 

 Discussion 
In the design grid in the Design view window, you can add field names. Field names 
identify the data in a field, such as OrderNumber, representing a field containing the 
order number for an order. Field names can be up to 64 characters long and can 
include letters, numbers, and spaces (field names cannot begin with spaces). Field 
names cannot contain a period (.), an exclamation point (!), a back quote (`), brackets 
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([ ]), or ASCII control characters. In addition, field names within a table must be 
unique. 
 
Making the field names descriptive and meaningful can help with data entry and data 
retrieval. However, you should avoid very long and complicated field names because 
they can be cumbersome to remember and reference when performing database 
functions. 
 

  

 
The order of the field names in Design view determines the 
order of column headings in the table. 

  

 
It can be beneficial not to include spaces in field names if you 
work with other database formats or plan to write VBA code. 

  
 

 Steps 

1. Open the desired database. 

2. Open or create a table in Design view. 

3. Type the first field name. 

4. Press [Down]. 

 

ASSIGNING DATA TYPES 

 Discussion 
Every field has a data type. The data type tells Access what kind of values you plan to 
store in the field and how much storage space to set aside for the field. While you can 
change a data type after a field contains data, this procedure may erase some or all the 
information in that field. 
 
The following table describes the available data types in Access: 

 
Data Type Description 

Text A Text field is the default data type and can contain any 
combination of letters, numbers, punctuation marks, and 
spaces. The default width is 50 characters and the maximum 
length is 255 characters. 
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Data Type Description 

Memo A Memo field is similar to a Text field, except that a Memo 
field can contain up to 65,535 characters. You can use Memo 
fields for notes or long descriptions in a database. 

Number A Number field can contain only numeric characters, a 
comma (used as a thousands separator), a period (used as a 
decimal point), and a hyphen (used as a negative number 
sign). You use a Number field only when you want to 
perform calculations using the values in the field. For 
example, even though zip codes and telephone numbers 
consist of numeric characters, you would not want to use them 
in calculations. Therefore, they should not be Number fields. 

Date/Time A Date/Time field contains a date and/or a time. Access 
automatically validates the entry, ensuring that it is a valid 
date and/or time. For example, Access does not allow you to 
enter 2/31/99 since February does not have 31 days. 
Date/Time fields are useful in performing calculations on 
dates and times. 

Currency A Currency field is similar to a Number field and can be 
used in calculations. However, the values in a Currency field 
can only have four decimal places, and they automatically 
appear with dollar signs and thousands separators (commas). 
You should use Currency fields whenever possible because 
they use fixed point calculation, which is faster than the 
floating point calculation used in Number fields. 

AutoNumber An AutoNumber data type means that Access automatically 
assigns a unique number (consecutively from 1) to each 
record in the database. You cannot manually enter a value into 
the field or change the number once Access assigns it. You 
use this data type when you want a unique identification 
number for every record. 

Yes/No A Yes/No field signifies one of two conditions, Yes or No. 
You use a Yes/No field when only two possibilities (i.e., True 
or False) exist for a field value. 

OLE object An OLE object field connects a field to other Windows 
applications. You use an OLE object data type for graphics, 
spreadsheets, or sound files. 

Hyperlink A Hyperlink field stores a link to anywhere you choose. The 
link could go to an Internet page, a Word document on an 
intranet, or even a form in the current database. A Hyperlink 
field can contain a description, an address, and a sub-address. 
Each part is separated by a number sign (#) and can contain 
2,048 characters. However, only the address is mandatory. 
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Data Type Description 

Lookup Wizard Selecting the Lookup Wizard data type guides you through 
steps to create a Lookup field. A Lookup field contains a list 
of selected values from another table or a list of values that 
you provide. You can choose values from the list to reduce 
repetitive data entry. 

 

 
Assigning data types 

 

 Steps 

1. Open the desired database. 

2. Open or create a table in Design view. 

3. Enter field names as desired. 

4. Select the Data Type column of the field for which you want to 
change the data type. 

5. Select the Data Type list. 

6. Select the desired data type. 
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ADDING A FIELD DESCRIPTION 

 Discussion 
You can enter an optional description for each field in the Description column in the 
design grid. The description appears on the status bar when the field is accessed on a 
form. You can enter brief comments as to the purpose of the field or the data that 
should be stored in it. 

 
A field description 

 

 Steps 

1. Open the desired database. 

2. Open or create a table in Design view. 

3. Enter field names as desired. 

4. Select the Description column of the field to which you want to add 
a description. 

5. Type the desired description. 
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SETTING A PRIMARY KEY 

 Discussion 
Access works most efficiently if you specify a primary key for a table. The primary 
key is a field or group of fields that uniquely identifies each record. Therefore, the 
value of the key field, or the combined values of a group of key fields, must not be 
found in more than one record. 
 
There are several advantages to setting a primary key for a table. First, the primary 
key is automatically indexed, which makes information retrieval faster. Second, when 
you open a table, the records are automatically sorted in order by the primary key. 
Finally, a primary key prevents entry of duplicate data because Access does not allow 
duplicates in the primary key field. 
 

  

 
If you have trouble identifying a field to be the primary key, it 
is best to create an AutoNumber field and designate it as the 
primary key. 

  

 
You cannot choose a Memo, OLE, or Hyperlink field as the 
primary key. 

  

 
To create a multi-field primary key, hold [Ctrl], click the 
desired fields, and then click the Primary Key button on the 
Table Design toolbar. 

  
 

 Steps 

1. Open the desired database. 

2. Open or create a table in Design view. 

3. Enter field names as desired. 

4. Select the row for the field you want to designate as the primary key. 

5. Click the Primary Key button  on the Table Design toolbar. 
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SAVING A NEW TABLE 

 Discussion 
After you design the fields for a table, you must save the table design before you can 
add any data. When you save a new table, you should give it a name that describes the 
records it stores. You can use up to 64 characters, including spaces. These characters 
can include letters, numbers, and spaces. They cannot contain a period (.), an 
exclamation point (!), a back quote (`), brackets ([]), or ASCII control characters. 
 
After you save a table, an icon with the table name appears as a Tables object in the 
Database window. 
 

  

 
When you save a table to a database file for the first time, 
Access opens the Save As dialog box in which you enter the 
desired table name. 

  

 
When you save a table, you are not creating a file. You are 
adding an object to the database file. 

  
 

 Steps 

1. Open the desired database. 

2. Create a table in Design view. 

3. Enter the desired table data. 

4. Click the Save button  on the Table Design toolbar. 

5. Type a name for the table. 

6. Select OK. 

 

USING THE TABLE WIZARD 

 Discussion 
You can use the Table Wizard to lead you through the steps to create a new table. The 
Table Wizard contains a set of models or templates for typical business and personal 
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tables. You select the type of table you want to create, then select the predefined fields 
you want to add to the table. 

 
Using the Table Wizard 

 
  

 
If the database does not contain any tables when you begin the 
Table Wizard, you will not be able to relate the new table to 
other tables in the database. 

  

  
You can use the right-pointing double arrow button on the first 
page of the Table Wizard to select all the sample fields for use 
in your new table and you can use the left-pointing arrow 
buttons to remove selected fields from your new table. 

  

 
You can rename fields for use in your new table by selecting 
the desired field in the Fields in my new table list box on the 
first page of the Table Wizard and then selecting the Rename 
Field button. 

  

 
You can also activate the Table Wizard by selecting the 
Create table by using wizard option in the Tables object list 
in the Database window and then selecting the Open button 
on the Database window toolbar. 
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 Steps 

1. Open the desired database. 

2. Display the Tables object list. 

3. Select the New button  on the Database window toolbar. 

4. Select Table Wizard. 

5. Select OK. 

6. Select the Business or Personal option. 

7. Select a sample table from the Sample Tables list box. 

8. Select the first field you want to add to the table in the Sample 
Fields list box. 

9. Select  to the right of the Sample Fields list box. 

10. Add other fields as desired. 

11. Select Next. 

12. Type a name for the table in the What do you want to name your 
table? text box. 

13. Select the desired option for the primary key. 

14. Select Next. 

15. Select the What field will hold data that is unique for each 
record? list. 

16. Select the desired field. 

17. Select the desired option for creating the data in the primary key 
field.  

18. Select Next. 

19. Select Relationships to relate the new table to any other tables in the 
database, if desired. 

20. Select the appropriate relationship option. 

21. Select OK. 

22. Select Next. 

23. Select the option corresponding to the view you want to appear after 
you exit the wizard. 

24. Select Finish. 

 





 

 

LESSON 3 -  
WORKING WITH TABLES  

In this lesson, you will learn how to: 

• Use Datasheet view  

• Navigate fields in tables  

• Add records  

• Move through records  

• Select records  

• Edit records  

• Save records  

• Delete records  
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USING DATASHEET VIEW 

 Discussion 
When you open a table, it appears in Datasheet view by default. Datasheet view is 
useful when you want to enter, edit, or delete records. 
 
The table data is arranged in rows and columns. The columns are fields and the rows 
are records. Multiple records can appear at the same time. The small box to the far left 
of the table is the record selector. A black triangle appears in the record selector to 
indicate the current record. 

 
Datasheet view 

 

NAVIGATING FIELDS IN TABLES 

 Discussion 
As you enter or edit data, you can use the mouse or the keyboard to move to the next 
field. If there are too many fields to display in Datasheet view, the window scrolls 
automatically as you move to the right or left. You can also use the navigation buttons 
at the bottom of the datasheet to move between fields. 
 
As you enter or edit data, you can use the [Tab] or [Enter] keys to move from field to 
field. You can also use the arrow keys to navigate fields in a table. These keys are 
helpful because they allow you to keep your hands on the keyboard at all times, rather 
than having to switch back and forth from the keyboard to the mouse. However, the 
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mouse is useful if you want to skip certain fields. You simply click in the field where 
you want to enter or edit data. 
 

  

 
You can also use the keyboard to move through records. The 
arrow keys move the insertion point up and down one record 
and the [Page Up] and [Page Down] keys display the 
previous and next pages of records, respectively. 

  
 

ADDING RECORDS 

 Discussion 
Following the last existing record in a table is a blank row, which displays an asterisk 
(*) in the record selector. This blank row is a new record row, which you can use to 
add data to a table. In a table, you add a new record by moving to the new record row 
and typing the data in the appropriate fields. If there is no data in the table, only a new 
record row appears. You can enter data into it immediately. As soon as you begin 
entering data into the new record row, Access creates a new record row below it. A 
pencil appears in the record selector to indicate the record being entered or edited. 
 
When you enter data into a row, the amount of characters you can enter is limited by 
the size of the field. The field size may actually be larger than the column width in 
Datasheet view. If the field size is larger than the column width, the text scrolls as 
you type. 

 
Adding records 
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You can use the Clipboard toolbar to enter repeated values 
into fields. You can copy as many as twelve separate entries to 
the Office Clipboard. To display the Office Clipboard, right-
click any toolbar and select the Clipboard command. Each 
copied item appears as an icon on the toolbar. When you point 
to an entry, a description of the contents of the copied item 
appears. Clicking the icon inserts the copied values into the 
selected field. 

  

 
You can also use the New Record button on the Table 
Datasheet toolbar or at the bottom of the datasheet to add a 
new record. 

  

 
You can also use the [Tab] key to move to the next field in a 
table. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Click in the first field of the new record row, if necessary. 

4. Type the desired data into the first field of the new record. 

5. Press [Enter]. 

6. Continue typing the desired data into the appropriate fields, pressing 
[Enter] after each entry. 

 

MOVING THROUGH RECORDS 

 Discussion 
If there are too many records in a table to display in Datasheet view, a scroll bar 
appears on the right side of the Datasheet view. You can use this scroll bar to view 
additional records. Access also includes navigation buttons at the bottom of the 
datasheet that can be used as shortcuts to moving through the data. These buttons and 
their functions are listed in the following table: 
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Button Description 

 Moves to the first record in the table. 

 Moves to the previous record in the table. 

 Moves to the next record in the table. 

 Moves to the last record in the table. 

 
 

  

 
You can also use the keyboard to move through records. The 
arrow keys move the insertion point up and down one record 
and the [Page Up] and [Page Down] keys display the 
previous and next pages of records, respectively. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Click the Last Record button  at the bottom of the Datasheet 
view window. 

4. Click the First Record button  at the bottom of the Datasheet 
view window. 

5. Click the Next Record button  at the bottom of the Datasheet 
view window. 

6. Click the Previous Record button  at the bottom of the 
Datasheet view window. 

 

SELECTING RECORDS 

 Discussion 
Selecting a record is different than just scrolling the view so that you can see the data 
in the record. When you select a record, that record becomes the active record. A 
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black triangle appears in the record selector to the left of the record to indicate the 
active record. 
 
Selecting a record is useful when you want to delete or copy the data contained in the 
record. For example, if you need to add a record containing almost identical 
information to the current record, you can select the current record and copy the data 
in order to paste and edit it as a new record. 
 

  

 
You do not need to select the entire row in order to select a 
record. As long as the insertion point is in the record and the 
black triangle appears in the record selector, the record is 
selected. However, in order to copy the data in the record, you 
must select the entire record. 

  

 
You can also use the keyboard to select a record. The arrow 
keys move the insertion point up and down one record and the 
[Page Up] and [Page Down] keys select the first record on 
each page of the datasheet. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Point to the record selector to the left of the desired record. 

4. Select the record selector to the left of the desired record. 

 

EDITING RECORDS 

 Discussion 
You can edit records at any time in Access. However, you cannot edit AutoNumber 
fields because Access automatically assigns a number to each record in AutoNumber 
fields. 
 
When you edit records, a pencil appears in the record selector to the left of the record 
you are editing. The following table describes various keystrokes you can use to 
quickly edit records in Access: 
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Keystroke Description 

[Up] Moves the insertion point to the same field in 
the previous record and selects the entire 
contents of the field. 

[Down] Moves the insertion point to the same field in 
the next record and selects the entire contents of 
the field. 

[Right] When the entire field is selected, this key 
moves the insertion point to the next field in the 
record and selects the entire contents of the 
field. When the field is not selected and the 
insertion point is positioned in the contents of 
the field, this key moves the insertion point one 
character to the right. 

[Left] When the entire field is selected, this key 
moves the insertion point to the previous field 
in the record and selects the entire contents of 
the field. When the field is not selected and the 
insertion point is positioned in the contents of 
the field, this key moves the insertion point one 
character to the left. 

[F2] Toggles between selecting and deselecting the 
current field. 

[Ctrl+Enter] Inserts a new line character in the field. 

[Ctrl+’] Replaces the contents of a field with the 
contents from the same field in the previous 
record. 

[Ctrl+Alt+Spacebar] Replaces the contents of the field with the 
default contents, if one was specified. 

[Ctrl+Shift+:] When the field is selected, this key combination 
replaces the contents of the field with the 
current time. 

[Ctrl+;] When the field is selected, this key combination 
replaces the contents of the field with the 
current date. 
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 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the field you want to edit. 

4. Position the insertion point as necessary. 

5. Edit the record as desired. 

 

SAVING RECORDS 

 Discussion 
Access automatically saves new records or changes made to existing records when 
you move to another record in a table. You can also save a record manually. This 
option is useful if the record has numerous fields and you want to save the changes to 
each individual field rather than waiting until you move to the next record. 
 

  

 
Access also saves records automatically when you close a 
table. 

  

 
You can also press the [Shift+Enter] key combination to save 
a record. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the Records menu. 

4. Select the Save Record command. 
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DELETING RECORDS 

 Discussion 
When you no longer need the information in a record, you can delete the record. 
Deleting records saves disk space and keeps your tables small.  

 
Deleting records 

 
  

 
After you confirm that you want to delete record(s), you 
cannot undo the deletion. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the record you want to delete. 

4. Click the Delete Record button  on the Table Datasheet 
toolbar. 
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5. Select Yes to delete the record. 

 



 

 

LESSON 4 -  
SETTING FIELD PROPERTIES  

In this lesson, you will learn how to: 

• Use field properties  

• Limit field size  

• Set number formats  

• Set date/time formats  

• Set yes/no formats  

• Set default values  

• Set validation rules  

• Create an input mask  
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USING FIELD PROPERTIES 

 Discussion 
Each field has a set of properties that control the way it stores, handles, and displays 
data. Setting field properties saves time in the later stages of building a database 
because they are used for forms and reports you create. Therefore, you will have less 
design work to do in later stages if you set field properties before you create forms 
and reports. 
 
You normally set properties when you create a table in Design view. If you saved the 
table using the default properties, you can display it in Design view to change the 
property settings. 
 
The field properties available in the Field Properties pane of the Design view 
window depend on the data type selected in the design grid. Some of the property 
types you can set are listed in the following table: 

 
Property type Description 

Field Size Limits a Text field to a specific number of 
characters or a Number field to the range of 
numbers it can store. 

Format Controls the way data appears in Datasheet 
view. 

Decimal places Displays a set number of decimal places. This 
property type has no effect on Number fields 
using the General format and is available for 
Number and Currency fields only. 

Input Mask Sets a pattern that determines the input format of 
data, such as the hyphens in a telephone number. 

Caption Specifies a label other than the field name that 
appears in the table and on forms and reports. 

Default Value Displays a specified value for a field in new 
records. 

Validation Rule Limits the data entered to meet a certain 
requirement. For example, you can specify that 
the Credit Limit field cannot be over $10,000. 

Validation Text Specifies the text you want to appear in an error 
message if the data entered violates the validation 
rule. 
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Property type Description 

Required Specifies that the field cannot be left empty when 
entering data into a record. 

Allow Zero Length Determines whether or not you can enter adjacent 
quotation marks (“ ”) in a field to indicate that 
there is no data for that field in the record. 

Indexed Speeds up retrieval of data in a field. All primary 
key fields are automatically indexed. 

 
 

  

 
When you select a field property, a brief description of the 
property appears in the description box on the right side of the 
Field Properties pane in the Design view window. You can 
press the [F1] key for help about a specific property. 

  
 

LIMITING FIELD SIZE 

 Discussion 
When you set a field size, you can only enter as much data into the field as allowed 
within the set parameters. After typing the maximum number of characters allowed, 
further keystrokes are not permitted. 
 
You can only set the Field Size property for Text, Number, and AutoNumber fields. 
All the other field data types have default widths that are set automatically. For a Text 
field, you simply type the maximum number of characters you want to allow in the 
field up to a maximum number of 255 characters allowed by Access. For Number 
fields, you have a number of options, which are listed in the following table: 

 
Field Size Size Range Decimal 

Places 

Byte 0 to 255 (no fractions) None. Data is 
rounded. 

Integer -32768 to 32767 (no fractions) None. Data is 
rounded. 

Long Integer -2,147,483,648 to 2,147,483,647 
(no fractions) 

None. Data is 
rounded. 

Single -3.4x1038 to 3.4x1038 Up to 7. 
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Field Size Size Range Decimal 
Places 

Double -1.797x10308  to 1.797x10308 Up to 15. 

ReplicationID Globally unique identifier. Not available. 

 
 

  

 
The Byte field size for Number fields can only store positive 
numbers. 

  

 
The default field size for Number fields is Long Integer. This 
size is also the largest field size. However, you should use the 
smallest possible field size so that the fields use less storage 
space and can be processed faster. 

  
 

  

 
You may lose existing data if you decrease the original field 
size. You cannot undo changes to the design after you have 
saved it. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Design view. 

3. Select the field for which you want to set a field size. 

4. Select the Field Size property on the General page in the Field 
Properties pane. 

5. Select the Field Size list or enter the desired value. 

6. Select the desired field size option, if applicable. 
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SETTING NUMBER FORMATS 

 Discussion 
The Format property affects how data appears on the screen in Datasheet view, not 
how it is stored in the table or used in calculations. For example, with 0 decimal 
places, 1.5 appears as 2, but when it is multiplied by 2, the answer is 3, and not 4. 
 
The available formats for fields with Number data types are listed in the following 
table: 

 
Format Description 

General Displays a number the way it was entered. This is the 
default format. 

Currency Uses a comma as a thousands separator and displays a 
currency symbol. Negative numbers display in parentheses. 
The default number of decimal places is 2. 

Fixed Displays at least one digit. The default number of decimal 
places is 2. The number in the field is rounded to the set 
number of decimal places. 

Standard Uses a comma as a thousands separator. The default 
number of decimal places is 2. 

Percent Multiplies the number entered by 100 and places a percent 
symbol at the end. The default number of decimal places is 
2. 

Scientific Expresses numbers as multiples of exponents of 10 in 
standard scientific notation. 
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Setting number formats 

 

 Steps 

1. Open the desired database. 

2. Open the desired table in Design view. 

3. Select the field for which you want to set a number format. 

4. Select the Format property on the General page in the Field 
Property pane. 

5. Select the Format list. 

6. Select the desired number format. 

 

SETTING DATE/TIME FORMATS 

 Discussion 
You can also change the format of a field with a Date/Time data type to change the 
way the date or time appears in a table. The available formats for fields with 
Date/Time data types are listed in the following table: 
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Format Description 

General Date If the value is only a date, no time appears. If the 
value is only a time, no date appears. This format is 
the default. 

Long Date The day and month names are spelled out, such as, 
Tuesday, July 4, 1995. 

Medium Date The month name is abbreviated and the name of the 
day is omitted, such as, 04-Jul-95. 

Short Date The date appears as numbers separated by slashes, 
such as, 7/4/95. 

Long Time Times appear with hours, minutes, and seconds, 
separated by colons and followed by an AM or PM 
indicator, such as, 6:30:15 PM. 

Medium Time This format is the same as the Long Time format 
except that no seconds appear, such as, 06:15 PM. 

Short Time The time appears in the 24-hour clock format with no 
seconds, such as, 18:30. 

 
 

  

 
Default date and time formats are determined by the settings 
in the Regional Settings section of the Windows Control 
Panel. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Design view. 

3. Select the field for which you want to set a date/time format. 

4. Select the Format property on the General page in the Field 
Properties pane. 

5. Select the Format list. 

6. Select the desired date/time format for the field. 
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SETTING YES/NO FORMATS 

 Discussion 
Fields with Yes/No data types can display yes or no, true or false, or on or off. You 
can specify which format to display in the field. If you specify True/False as the 
format and a user enters Yes, Access automatically converts it to True. 

 
Setting yes/no formats 

 

 Steps 

1. Open the desired database. 

2. Open the desired table in Design view. 

3. Select the field for which you want to set a yes/no format. 

4. Select the Format property on the General page in the Field 
Properties pane. 

5. Select the Format list. 

6. Select the desired yes/no format. 
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SETTING DEFAULT VALUES 

 Discussion 
You can set a default value for a field using the Default Value property. The default 
value is automatically entered in the field when you create a new record. Changes will 
not be added to previous entries. You can then change the value if it is not appropriate 
for the record you are entering. A default value saves time in data entry. For example, 
if your table contains the names and addresses of clients, and most of your clients are 
in New York state, you can set the default value in the state field to NY. If a client 
resides in Connecticut, you can change the entry for that individual record. 
 
To set a default value, you enter an expression for the Default Value property. An 
expression consists of operators (i.e. =, +, -, *, /) and/or values. You can enter an 
expression directly into the Default Value text box, or you can use the Expression 
Builder. The Expression Builder button appears to the right of the Default Value 
text box when you select it. 
 
The Expression Builder dialog box contains the available functions, operators, and 
constants you can use to create an expression. A function calculates a value based on 
the results of its built-in formula. A constant is a value that does not change, such as 
True or False. As you select items in the list boxes in the lower half of the dialog box 
or click any of the available buttons, Access creates the expression in the list box in 
the top half of the dialog box. 
 
If you create an expression for a Text field, the value must be enclosed in quotation 
marks (“ ”); for example, “Net 30”. Values for Date fields must be enclosed in 
number signs (#); for example, #1/15/95#. If you do not enter the number signs, 
Access will automatically enter them. 
 

  

 
You cannot set a default value for fields with AutoNumber or 
OLE object data types. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Design view. 

3. Select the field for which you want to set a default value. 

4. Select the Default Value property on the General page in the Field 
Properties pane. 
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5. Create the desired expression. 

6. Press [Enter]. 

 

SETTING VALIDATION RULES 

 Discussion 
You can set a validation rule for a field using the Validation Rule property. Access 
checks the validation rule when you enter data into a field of a new record. If the 
value you enter does not meet the conditions of the validation rule, Access displays a 
warning box to indicate the error. You specify the text you want to appear in the 
warning message in the Validation Text property. 
 
Setting a validation rule is different from setting data type or field length. Access uses 
data type and field length to determine that the correct type of data is being entered 
and that the data is not too long. For example, if you set a data type as Number, 
Access does not allow you to enter text characters. Access also restricts you from 
entering a number that is too large for the parameters of the field size. While these 
restrictions allow Access to verify that you are entering the right type and length of 
data, they are not validation rules. Validation rules are more specific in their 
restrictions. A validation rule allows you to set specific conditions so that only certain 
types of data can be entered. For example, you can create a validation rule so that 
numbers entered in a particular field must be between 500 and 1000. 
 
To set a validation rule, you enter an expression for the Validation Rule property. 
You can enter an expression directly into the Validation Rule property, or you can 
use the Expression Builder. The Expression Builder button appears to the right of the 
Validation Rule property when you select it. The Expression Builder dialog box 
contains the available functions, operators, and constants you can use to create an 
expression. As you select items in the list boxes in the lower half of the dialog box or 
click any of the available buttons, Access creates the expression in the list box in the 
top half of the dialog box. 
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Setting a validation rule 

 

 Steps 

1. Open the desired database. 

2. Open the desired table in Design view. 

3. Select the field for which you want to set a validation rule. 

4. Select the Validation Rule property on the General page in the 
Field Properties pane. 

5. Type the desired validation rule. 

6. Select the Validation Text property on the General page in the 
Field Properties pane. 

7. Type the desired validation text. 

 

CREATING AN INPUT MASK 

 Discussion 
To ensure data is entered in a specific manner, you can create an input mask. An input 
mask allows you to define how the data is entered into the field. Since the input mask 
controls what values users can enter in a field, it often makes data entry easier in 
addition to controlling the entries. You can create an input mask by entering the 
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criteria directly into the field property. However, it is often easier to use the Input 
Mask Wizard to set the property for you. 
 
The Input Mask Wizard offers several predefined input masks for items such as dates, 
ZIP codes, telephone numbers, times, etc. The wizard allows you to modify the 
predefined input mask to meet your needs and define how the data may be saved. 

 
The Input Mask Wizard 

 
  

 
You can get specific information on how to create or modify 
an input mask by clicking in the Input Mask field property 
and pressing the [F1] key. 

  

  
Data that has already been entered into the field is not affected 
when an input mask is applied. The input mask only affects 
new entries. 

  

 
You can also open the Input Mask Wizard by right-clicking in 
the desired Input Mask field and then selecting the Build 
command or by clicking the Build button on the Table Design 
toolbar. 

  
 



Creating Tables Using Access 2000 Lesson 4 - Setting Field Properties 

US Senate Office of Education and Training Page 49
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Design view. 

3. Select the field for which you want to set a number format. 

4. Select the Input Mask property on the General page in the Field 
Properties pane. 

5. Click the Build button. 

6. Select the desired input mask option in the Input Mask list.  

7. Select Next.  

8. Select the Placeholder Character list. 

9. Select the desired placeholder, if necessary. 

10. Select Next.  

11. Select whether or not you want to store the data with the symbols in 
the mask.  

12. Select Next.  

13. Select Finish.  

 





 

 

LESSON 5 -  
EDITING TABLES  

In this lesson, you will learn how to: 

• Change the row height  

• Change the column width  

• Change a font attribute  

• Change a cell effect  

• Select a column  

• Move a column  

• Hide a column  

• Unhide a column  

• Freeze a column  
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CHANGING THE ROW HEIGHT 

 Discussion 
The standard height for rows in a table is 12.75. You can change the row height to 
allow field entries that are too long to wrap. This option allows you to display more of 
the data. Changing the height of a single row changes the height of every row in the 
table. 
 

  

 
You can also select the Format menu and then select the Row 
Height command to open the Row Height dialog box. In this 
dialog box, you can set a desired row height or select the 
Standard Height option to return the rows to the default 
height of 12.75. 

  

 
You cannot undo changes to the row height by selecting the 
Edit menu and then selecting the Undo command. To undo 
the changes, you must close the table without saving the 
changes. 

   
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Point to a line between any two record selectors. 

4. Drag the line to the desired height. 

 

CHANGING THE COLUMN WIDTH 

 Discussion 
The standard width for columns in a table is 15.6667. You can change the column 
width to display any data in a field that is truncated. By widening the column, you 
allow more of the data to appear in the display. 
 

  



Creating Tables Using Access 2000 Lesson 5 - Editing Tables 

US Senate Office of Education and Training Page 53
 

 
You can select the Format menu and then select the Column 
Width command to open the Column Width dialog box. In 
this dialog box, you can set a desired column width or select 
the Standard Width option to return the columns to the 
default width of 15.6667 points. 

  

 
You cannot undo changes to a column width by selecting the 
Edit menu and then selecting the Undo command. To undo 
the changes, you must close the table without saving the 
changes. 

  

 
If you double-click a column separator line to the right of a 
column header, the width for that column automatically 
adjusts to the most appropriate width to display the data in the 
fields. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Point to the separator line to the right of the column header for the 
column width you want to adjust. 

4. Drag the line to the desired width. 

 

CHANGING A FONT ATTRIBUTE 

 Discussion 
You can change font attributes in Datasheet view using the Font Command dialog 
box. Changing font attributes changes the display of the data and the column 
headings. In the Font Command dialog box, you can change the font type, style, and 
size, as well as any font effects. 
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 
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3. Select the Format menu. 

4. Select the Font command. 

5. Change font attributes as desired. 

6. Select OK. 

 

CHANGING A CELL EFFECT 

 Discussion 
You can change the way cells appear in Datasheet view. For example, you can make 
cells raised or sunken. You can also change the look of the horizontal and vertical 
gridlines, as well as the background of cells. The Sample box in the Datasheet 
Formatting dialog box displays the results of your changes. 

 
Changing a cell effect 
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 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the Format menu. 

4. Select the Datasheet command. 

5. Change the cell effects as desired. 

6. Select OK. 

 

SELECTING A COLUMN 

 Discussion 
Before you can manipulate entire columns in a table, you must select them. You can 
perform a number of actions on columns once they are selected. You can select a 
single column or multiple adjacent columns. 
 

  

 
To select multiple adjacent columns, drag across the column 
headers. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Point to the column header of the column you want to select. 

4. Select the column header. 
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MOVING A COLUMN 

 Discussion 
You can move columns in Datasheet view. For example, you can reposition columns 
to view data more easily or organize it more logically. You can move a single column 
or multiple adjacent columns. You must select the column or columns before you can 
move them. 
 

  

 
Moving columns does not change the order of the fields in the 
table design. 

  

 
You cannot undo the changes to a column position by 
selecting the Edit menu and then selecting the Undo 
command. To undo the changes, you must close the table 
without saving the changes. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the column(s) you want to move. 

4. Drag the column(s) to the new location. 

 

HIDING A COLUMN 

 Discussion 
If you do not intend to use certain fields, you can choose not to display them on the 
desktop by hiding the appropriate column(s). You can hide a single column or 
multiple adjacent columns. 
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 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the column(s) you want to hide. 

4. Select the Format menu. 

5. Select the Hide Columns command. 

 

UNHIDING A COLUMN 

 Discussion 
You can display hidden columns. Hidden columns are listed in the Unhide Columns 
dialog box. If a deselected check box appears beside a field name, it means that the 
column is hidden. You can select the check box to unhide the column. 

 
Unhiding a column 
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 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the Format menu. 

4. Select the Unhide Columns command. 

5. Select the column(s) you want to unhide. 

6. Select Close. 

 

FREEZING A COLUMN 

 Discussion 
As you scroll to the right in Datasheet view, the far left columns, which usually 
contain identifying information about the records, scroll off the screen. You can freeze 
these columns in Datasheet view. This option allows you to see the information in the 
frozen columns no matter how many columns you scroll to the right. 
 

  

 
A solid, dark line appears to the right of the frozen columns. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the column(s) you want to freeze. 

4. Select the Format menu. 

5. Select the Freeze Columns command. 

 



 

 

LESSON 6 -  
FINDING AND FILTERING DATA  

In this lesson, you will learn how to: 

• Sort records  

• Find specific records  

• Find records using wildcards  

• Use Replace  

• Use Filter By Selection  

• Apply/Remove a filter  

• Use Filter Excluding Selection  

• Use the Filter For feature  

• Use Filter By Form  
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SORTING RECORDS 

 Discussion 
When you display a table in Datasheet view, Access displays the records in order by 
their primary key. You may want to edit or print records in another order; for 
example, by last name, zip code, or amount due. 
 
You can sort records in either ascending or descending order. Ascending order sorts 
the column from 0 to 9 and then A to Z. Descending order sorts the column from 9 to 
0 and then Z to A. The toolbar includes buttons for both types of sorts. 
 

  

 
You can remove a sort by selecting the Records menu and 
then selecting the Remove Filter/Sort command. 

  

 
You can also sort records in a table by selecting the Records 
menu, pointing to the Sort command, and selecting the Sort 
Ascending or Sort Descending command, or by right-
clicking in Datasheet view and selecting the Sort Ascending 
or Sort Descending command. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the field by which you want to sort. 

4. Click the Sort Ascending button  or Sort Descending button 

 on the Table Datasheet toolbar. 
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FINDING SPECIFIC RECORDS 

 Discussion 
The Find feature in Access allows you to locate records quickly. You can search for 
records that contain a unique value in a certain field or find all records that have a 
common value in a field. You use the Find Next button to begin the search. Access 
scans the selected field, beginning with the current record, and finds the first record it 
encounters with matching data. Use the Find Next button repeatedly to find additional 
records containing the same matching data. 
 
In the Find and Replace dialog box, you select options from either the Look In or 
Match lists to control the way Access searches for matching records. The Look In list 
enables you to search a specific column. If you are not sure in which column the 
search criteria is located, you can use the Table option to search the whole table. The 
Match list provides options that enable you to define whether the contents of the 
whole field, only part of the field, or only the beginning of the field should match the 
search text. 
 
The Find and Replace dialog box remains open while you perform a search. If desired, 
you can move the dialog box to another location to view the search as it progresses. 
When the search is finished, a Microsoft Access message box opens, displaying a 
message appropriate to the search. 
 

  

 
The Find and Replace dialog box maintains the settings of the 
most recent search when you close it. If you want to search 
again for the same text, you do not need to enter the settings 
again. You can press the [Shift+F4] key combination to 
perform the same search again. 

  

 
You can also open the Find and Replace dialog box by 
selecting the Edit menu and then selecting the Find command 
to find records or the Replace command to find records and 
replace data. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the field that contains the data you want to find. 
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4. Click the Find button  on the Table Datasheet toolbar. 

5. Type the text you want to find in the Find What text box. 

6. Select the Match list. 

7. Select the desired Match option. 

8. Select Find Next to display the first matching record. 

9. Select Find Next repeatedly to find any additional matching records. 

10. Select OK to close the Microsoft Access warning dialog box. 

11. Select Cancel to close the Find and Replace dialog box. 

 

FINDING RECORDS USING WILDCARDS 

 Discussion 
When you perform a find, you can use wildcards in the Find and Replace dialog box. 
Wildcards are characters that represent other characters. They allow you to find 
records even though you may be unsure how the complete entry appears in the field. 
Wildcards also allow you to find records that share a common entry within a field, but 
not necessarily the entire field entry. For example, you may want to search for the area 
code at the beginning of a telephone number field. 
 
The wildcards available in Access are listed in the following table: 

 
Wildcard Description 

* Represents any number of characters. It can be used 
anywhere in the search text. For example, entering North* 
finds all entries beginning with North, entering *Sports 
finds all entries ending with Sports, and entering *Sports* 
finds all entries containing Sports. 

? Represents only one character. For example, entering 
Sm?th finds Smith, Smyth, etc. 

[ ] Finds any character enclosed in the set. For example, 
entering b[ai]t finds bat and bit, but not bet and but. 

! Finds any character except the ones enclosed in the set. 
For example, entering b[!ai]t finds bet and but, but not bat 
and bit. 

- Finds any character in a range in a set. For example, 
entering b[u-w]t finds but, bvt, and bwt. 
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Wildcard Description 

# Represents only one digit. For example, entering 1980# 
finds 19801, 19802, 19803, etc. 

 
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the field containing the data you want to find. 

4. Click the Find button  on the Table Datasheet toolbar. 

5. Type the text you want to find in the Find What text box. 

6. Select the Match list. 

7. Select the desired Match option. 

8. Select Find Next to display the first matching record. 

9. Select Find Next repeatedly to find any additional matching records. 

10. Select OK to close the Microsoft Access warning dialog box. 

11. Select Cancel to close the Find and Replace dialog box. 

 

USING REPLACE 

 Discussion 
The Replace feature in Access allows you to locate records and quickly replace data 
in a field. This feature is especially useful if the same information must be changed in 
several records. Access scans the selected field, beginning with the current record, and 
finds the first record it encounters with matching data. You can then choose to replace 
the data or find the next occurrence of the entry. You can also choose to replace all the 
data at once. 
 
In the Find and Replace dialog box, you select options from either the Look In or 
Match lists to control the way Access searches for matching records. The Look In list 
enables you to search a specific column. If you are not sure in which column the 
search criteria is located, you can use the Table option to search the whole table. The 
Match list provides options that enable you to define whether the contents of the 
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whole field, only part of the field, or only the beginning of the field should match the 
search text. 
 
The Find and Replace dialog box remains open while you perform a search. If desired, 
you can move the dialog box to another location to view the records that are found in 
the search. When the search is finished, a Microsoft Access message box opens, 
informing you that the search is complete. 

 
Using Replace 

 
  

 
Selecting the Replace All button in the Find and Replace 
dialog box replaces all the data that matches the search 
criteria. Make sure that you want to replace all data that 
matches the search criteria before you use the Replace All 
button because you may not be able to retrieve the data once 
you replace it. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the field that contains the data you want to find. 

4. Click the Find button  on the Table Datasheet toolbar. 

5. Select the Replace tab. 

6. Type the text you want to find in the Find What text box. 

7. Select the Replace With text box. 

8. Type the replacement text. 

9. Select Find Next. 
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10. Select Replace. 

11. Select Replace All. 

12. Select Yes to replace the remaining matching records. 

13. Select Cancel to close the Find and Replace dialog box. 

 

USING FILTER BY SELECTION 

 Discussion 
You can filter data in Access. Filtering data refers to hiding all the data you do not 
want to see so that you can display the records with which you want to work. For 
example, in a customers table, you can filter data so that only records of customers 
located in a specific region appear in the view. 
 
A quick and easy way to filter data in Access is to use the Filter By Selection feature 
where you can select a field in a record that has the data you want to filter. Using the 
Filter By Selection feature then hides all the data except records that match the filter 
criteria. The filter remains in effect until you remove it. 

 
Filtering by selection 

 
  

 
When a filter is in effect, the (Filtered) indicator appears in 
the status bar at the bottom of Datasheet view. 
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You can also filter by a selection by selecting the Records 
menu and then selecting the Filter By Selection command, or 
by right-clicking in Datasheet view and selecting the Filter 
By Selection command. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the field that contains the data you want to filter. 

4. Click the Filter By Selection button  on the Table Datasheet 
toolbar. 

 

APPLYING/REMOVING A FILTER 

 Discussion 
The Apply Filter button acts a toggle. If a filter is in effect, it becomes the Remove 
Filter button. If no filter is in effect, it applies the most recent filter when you click it. 
 

  

 
You can also apply a filter by selecting the Records menu and 
then selecting the Apply Filter/Sort command. 

  

 
You can also remove a filter by selecting the Records menu 
and then selecting the Remove Filter/Sort command, or by 
right-clicking in the Datasheet view and selecting the 
Remove Filter/Sort command. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 
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3. Click the Apply Filter or the Remove Filter button  on the 
Table Datasheet toolbar. 

 

USING FILTER EXCLUDING SELECTION 

 Discussion 
The Filter Excluding Selection feature is similar to the Filter by Selection feature 
except that when you apply a filter of this type, Access displays all the records that do 
not match the filter criteria. For example, if most of the customers in a customers table 
are located in the state of NY, you can use the Filter Excluding Selection feature to 
display all the records of customers that are not located in NY. 
 

  

 
You can also filter records excluding the selection by right-
clicking in Datasheet view and selecting the Filter Excluding 
Selection command. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the field that contains the data you want to filter. 

4. Select the Records menu. 

5. Point to the Filter command. 

6. Select the Filter Excluding Selection command. 

 

USING THE FILTER FOR FEATURE 

 Discussion 
You can apply a filter to find specific records quickly using the Filter For feature. 
When you apply this type of filter, Access filters the table and displays only the 
records containing data that matches the filter criteria. This feature eliminates the 
process of having to scroll through a table in search of records on which to filter. 
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Using the Filter For feature 

 
  

 
You may use wildcards when using the Filter For feature. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Right-click a field in a column that contains the field to which you 
want to apply a filter. 

4. Select the Filter For text box. 

5. Type the desired filter criteria. 

6. Press [Enter]. 

 

USING FILTER BY FORM 

 Discussion 
You can use the Filter By Form feature to filter data. The Filter By Form feature 
displays what looks like a blank record in Form view. You then enter the data for 
which you want to search in the appropriate field. When you apply the filter, only 
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those records with matching data in the appropriate field appear. All the other records 
are hidden. 
 
When you select a field in the Filter By Form window in Form view, a list appears. 
This list displays the existing data in the field so that you can easily choose the data by 
which you want to filter. This option is useful because you do not have to remember 
exactly how the data was entered into the field. 

 
Filtering by form 

 
  

 
If you have used other methods to filter prior to using the 
Filter By Form feature, the most recent filter appears in the 
form. You can click the Clear Grid button to clear any 
previous filters. 

  

 
You can also enable the Filter By Form feature by selecting 
the Records menu, pointing to the Filter command, and 
selecting the Filter By Form command. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Click the Filter By Form button  on the Table Datasheet 
toolbar. 
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4. Click the Clear Grid button  on the Filter/Sort toolbar to clear 
any previous filters, if necessary. 

5. Select the field to which you want to apply a filter. 

6. Select the field list. 

7. Select the data by which you want to filter. 

8. Click the Apply Filter button  on the Filter/Sort toolbar. 

 



 

 

LESSON 7 -  
MODIFYING TABLES  

In this lesson, you will learn how to: 

• Insert a column in a table  

• Change a column name  

• Delete a column  

• Insert a lookup column  

• Insert a hyperlink column  
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INSERTING A COLUMN IN A TABLE 

 Discussion 
You may find it necessary to insert one or more columns in a table. When you insert a 
column, you add a new field to the table. You must specify the location for the new 
field within the table. Access sets a default field width, provides a default field name, 
and assigns a default data type (Text). You can change any of these default settings in 
Design view. 

 
Inserting a column in a table 

 
  

 
In Datasheet view, related or joined data in a table is 
indicated by a plus symbol (+) to the left of a record. Clicking 
the plus symbol (+) displays the related or joined data in a 
table. This table is referred to as a subdatasheet. The 
subdatasheet may be edited using the same methods you 
would use to edit a standard datasheet. 

  

 
After you add a column to a table, you should change the 
default field name to a name that clearly identifies the contents 
of that column. 

  

 
You can also insert a column by right-clicking a column 
heading and then selecting the Insert Column command. 
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 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Position the insertion point in the column to the left of which you 
want to insert the new column. 

4. Select the Insert menu. 

5.  Select the Column command. 

 

CHANGING A COLUMN NAME 

 Discussion 
A column name should clearly indicate the information that a column contains in 
order to make working with data easier. When you change the name of a column, you 
change the field name. When you are selecting a name for a column, keep in mind that 
you cannot use duplicate field names. In addition, column names can be up to 64 
characters long, but shorter names are recommended. 
 

  

 
You can also rename a column by right-clicking a column 
heading and then selecting the Rename Column command. 

  

 
Column names can contain spaces, numbers, and many special 
characters, except a period (.), an exclamation point (!), or 
square brackets ([ ]). 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Point to the column heading you want to change. 

4. Double-click the column heading. 

5. Type the new column name. 

6. Press [Enter]. 
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DELETING A COLUMN 

 Discussion 
There may be times when you want to delete a column in a table. When a column is 
deleted, the columns to the right automatically adjust to the left. If other database 
objects (such as lookup tables) contain references to a deleted field, they generate 
error messages unless they are deleted as well. 
 

  

 
You can also delete a column by right-clicking a column 
heading and then selecting the Delete Column command. 

  

 
You cannot delete a field that has been used in a relationship 
with another table unless you first delete the relationship. 

  
 

  

 
Once a column is deleted, all data contained in it is 
permanently deleted. You cannot undo the deletion after you 
confirm it. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Click in a field in the column you want to delete. 

4.  Select the Edit menu. 

5. Select the Delete Column command. 

6. Select Yes to confirm the deletion. 
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INSERTING A LOOKUP COLUMN 

 Discussion 
A lookup column saves time when you are entering data in a table by reducing the 
amount of information you must type in a field. A lookup column eliminates the need 
to search for information each time you want to add a record by looking up data in 
another data source. It also increases data entry accuracy by providing a list of 
standard values from which you can choose. 
 
The Lookup Wizard can assist you in creating a lookup column to suit your needs. 
The values in a lookup column can come from another table, a query, or your own list. 
For example, in one table, you may have a list of customers. In another table, you may 
have a list of customer types and information related to each customer type. In the 
customer table, you can use the data from the customer type table for a lookup 
column. When you are working in the customer table, you can choose the customer 
type from a list to make the entries more consistent. 
 
During data entry, a drop-down arrow automatically appears in a lookup column. You 
can use the arrow to access a list of values, or you can type a value that is not on the 
list directly into the column. 

 
Using a lookup column to enter information into a table 

 
  

 
You can also insert a lookup column by right-clicking a 
column heading and then selecting the Lookup Column 
command. 
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In a lookup column, if you click the right side of a field where 
the arrow is positioned, the arrow and the list appear together. 
You do not have to click in the field first and then click the 
arrow to access the list. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Position the insertion point in the column to the left of which you 
want to insert a lookup column. 

4. Select the Insert menu. 

5. Select the Lookup Column command. 

6. Select the option indicating how you want the lookup column to get 
its values. 

7. Select Next. 

8. Select the table or query you want to use to provide the values for the 
lookup column. 

9. Select Next. 

10. Add the field(s) you want to include in the lookup column from the 
Available Fields list box. 

11. Select Next. 

12. Point to the separator line to the right of the column header for the 
column width you want to adjust. 

13. Double-click the separator line to the right of the column header to 
automatically adjust the column width. 

14. Select Next. 

15. Type a label for the lookup column. 

16. Select Finish. 
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INSERTING A HYPERLINK COLUMN 

 Discussion 
When you insert a column in a table, Access assigns the Text data type as the default. 
However, you can insert a hyperlink column in a table, rather than a text column. A 
hyperlink field contains an address or path to another location, such as a network 
server or a page on the Internet. After you insert a hyperlink column, you can type a 
hyperlink address directly into the hyperlink field. Each record can contain a different 
hyperlink address. When you type the hyperlink address, the text appears underlined 
and in a different color, indicating the hyperlink. When you insert a hyperlink column, 
the column name defaults to Field1. You can change a hyperlink column name the 
same as you change a text column name. 

 
Inserting a hyperlink column in a table 

 
  

 
After you insert a hyperlink column in a table, you should 
change the default field name to a name that clearly identifies 
the contents of the column.  

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 
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3. Position the insertion point in the column to the left of which you 
want to insert a hyperlink column. 

4. Select the Insert menu. 

5. Select the Hyperlink Column command. 

 



 

 

LESSON 8 -  
CREATING RELATIONSHIPS  

In this lesson, you will learn how to: 

• Use related tables  

• Create a relationship  

• Set referential integrity  

• Create a many-to-many relationship  

• Add a table - Relationships window  
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USING RELATED TABLES 

 Discussion 
Tables can be joined, or related, in order to access and coordinate information in all 
the fields of the related tables. Joining tables is a useful way to avoid the need to enter 
duplicate information in various, related tables. In addition, it allows you to create 
reports, forms, and queries from the related data tables and save them in the database 
file. Relating tables allows you to create smaller, more efficient tables that can be 
related when you need access to the data. 
 
When you relate tables, the table from which you select the first join field is the 
primary table and the table to which you drag the join field is the related table. The 
tables must have some common fields that contain the same type of data. One of the 
fields in the primary table must be the primary key so that Access does not allow 
duplicate entries. The common fields in both tables must have the same or equivalent 
data types and; if they are Number fields, they must have the same field size. 
 
For example, you can create a table consisting of customer names, addresses, and 
telephone numbers. You can also include a unique identification number for each 
customer, which would be the primary key in the table. You can create this number or 
allow Access to create it for you. You could then create a separate table consisting 
only of orders placed by customers. This table would also contain the field for the 
unique customer identification number, but not the customers’ names, addresses, and 
telephone numbers. By relating the two tables through the common customer 
identification number field, the customers’ names, addresses, and telephone numbers 
do not have to be entered for every order. 
 
Access includes two basic types of relationships: one-to-many and one-to-one. A one-
to-many relationship occurs when one record from the primary table matches many 
records from the related table; for example, one customer record matches many order 
records. A one-to-one relationship occurs when one record from the primary table 
matches one record from the related table. Access determines the relationship type 
automatically when you create the relationship. 
 

CREATING A RELATIONSHIP 

 Discussion 
You create relationships between tables or queries in the Relationships window. The 
Relationships window displays a graphic representation of the relationships in the 
database.  
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When you are working in the Relationships window, you can reposition the field lists 
so that you can view the relationships more easily. In addition, the field name 
representing the primary key appears in bold in the tables. All tables must be closed 
before you can create relationships.  

 
The Relationships window 

 

 
The Show Table dialog box opens automatically if no tables 
have been added to the Relationships window. 

 
You can also open the Relationships window by selecting the 
Tools menu and then selecting the Relationships command or 
by right-clicking in the Database window and then selecting 
the Relationships command. 

 
You can also create relationships in the Show Table dialog 
box by selecting the tables you want to relate and pressing the 
[Enter] key. 

 

 Steps 

1. Open the desired database. 

2. Click the Relationships button  on the Database toolbar. 

3. Click the Show Table button  on the Relationships toolbar. 
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4. Select the first table. 

5. Select Add. 

6. Select the second table. 

7. Select Add. 

8. Select Close to close the Show Table dialog box. 

9. Select the join field in the field list for the first table. 

10. Drag the field on top of the matching field in the field list for the 
second table. 

11. Select Create. 

12. Click the Close button in the Relationships window. 

13. Select Yes to save the changes. 

 

SETTING REFERENTIAL INTEGRITY 

 Discussion 
When you create a relationship between two tables, you can set referential integrity. 
Referential integrity is a built-in set of rules Access uses to make sure that the 
relationship is valid. Referential integrity can also prevent accidental deletion or 
editing of data. In order to use referential integrity, the following conditions must be 
true: the related field in the primary table is the primary key, the related fields in both 
tables have the same data type, and both tables belong to the same database. 
 
When you set referential integrity, you must observe the following three rules. First, 
you cannot enter data in the join field in the related table that does not have a match in 
the join field in the primary table. Second, you cannot delete records from the primary 
table if there are matching records in the related table. Third, you cannot edit primary 
key values in the primary table if related records exist. 
 
However, if you want to perform the changes listed above and still maintain 
referential integrity, you can select the Cascade Update Related Fields and Cascade 
Delete Related Records options in the Edit Relationships dialog box. When either or 
both of these options are selected, Access makes the necessary changes to the related 
tables automatically to maintain referential integrity. It is recommended that these two 
options be used after careful consideration since the changes cannot be undone. 
 
When the referential integrity option is activated, Access displays symbols above the 
join line in the Relationships window to indicate the type of relationship: one-to-one 
or one-to-many. The number 1 above the join line next to a field list indicates “one”, 
while the mathematical symbol for infinity (which resembles a horizontal 8) indicates 
“many”. 
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The Edit Relationships dialog box 

 
  

 
You can also open the Edit Relationships dialog box by 
selecting the Relationships menu and then selecting the Edit 
Relationship command, or by right-clicking the join line and 
then selecting the Edit Relationship command. 

  
 

 Steps 

1. Open the desired database. 

2. Open the Relationships window. 

3. Double-click the desired join line. 

4. Select the Enforce Referential Integrity option. 

5. Select the Cascade Update Related Fields option, if desired. 

6. Select the Cascade Delete Related Records option, if desired. 

7. Select OK. 

 

CREATING A MANY-TO-MANY RELATIONSHIP 

 Discussion 
While one-to-many relationships are the most common, there are times when you may 
need to create a many-to-many relationship. In a many-to-many relationship, a record 
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in one table can have many matching records in another table, and vice versa. Many-
to-many relationships often apply to orders and product relationships, where an order 
can include many products, or where individual products may appear in many 
products. 
 
This type of relationship is often made possible by using a third table (called a 
junction table) that consists of its own primary key field and two foreign key fields, 
one from each of the two tables being related. A many-to-many relationship is really 
two one-to-many relationships linking to a third table. 
 

  

 
The Show Table dialog box opens automatically if no tables 
have been added to the Relationships window. 

  

 
You can also open the Relationships window by selecting the 
Tools menu and then selecting the Relationships command or 
by right-clicking in the Database window and then selecting 
the Relationships command. 

  

 
You can also create relationships in the Show Table dialog 
box by selecting the tables you want to relate and pressing the 
[Enter] key. 

  
 

 Steps 

1. Open the desired database. 

2. Click the Relationships button  on the Database toolbar. 

3. Click the Show Table button  on the Relationships toolbar, if 
necessary. 

4. Select the first table you want to relate. 

5. Select Add. 

6. Select the table you want to use as the junction table.  

7. Select Add. 

8. Select the third table you want to use in the relationship.  

9. Select Add. 

10. Select Close to close the Show Table dialog box. 
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11. Drag the foreign key field from the junction table field list to its 
corresponding key in the related table field list. 

12. Select the Enforce Referential Integrity option.  

13. Select Create. 

14. Drag the foreign key field from the junction table field list to its 
corresponding key in the related table field list. 

15. Select the Enforce Referential Integrity option.  

16. Select Create. 

17. Click the Close button in the Relationships window. 

18. Select Yes to save the changes. 

 

ADDING A TABLE - RELATIONSHIPS WINDOW 

 Discussion 
You can add additional tables to the Relationships window. For example, if you have 
two related tables and then decide you need to access information from a third table, 
you can easily add the required table to the Relationships window. 

 
Adding a table to the Relationships window 
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You can also open the Show Table dialog box by right-
clicking in the Relationships window and then selecting the 
Show Table command, or by selecting the Relationships 
menu and then selecting the Show Table command. 

  
 

 Steps 

1. Open the desired database. 

2. Open the Relationships window. 

3. Click the Show Table button  on the Relationship toolbar. 

4. Select the table you want to add. 

5. Select Add. 

6. Select Close to close the Show Table dialog box. 

 



 

 

LESSON 9 -  
USING EDITING TOOLS  

In this lesson, you will learn how to: 

• Run the spelling checker  

• Set AutoCorrect options  

• Add AutoCorrect entries  

• Delete AutoCorrect entries  
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RUNNING THE SPELLING CHECKER 

 Discussion 
You can invoke the spelling checker to spell check text in tables and text boxes in 
forms. In a table, you can check all columns or selected columns. 
 
When the spelling checker finds the first word that is not in a dictionary, it pauses and 
the Spelling dialog box opens. The Spelling dialog box does not open if there are no 
errors found. 
 
As the spell check proceeds, the spelling checker examines the words in the selection 
and compares them to the words in the main dictionary and your custom dictionary. In 
addition to searching for misspelled words, the spelling checker also identifies 
repeated words (such as the the). 
 
When a word is identified, the word appears in the Spelling dialog box, with the 
identified word appearing in the Not in Dictionary box. Possible correct spellings to 
this word are listed in the Suggestions list box. The identified word can be changed to 
one of these listed suggestions. You can use the Change button to modify only the 
current occurrence of the word or the Change All button to change all occurrences of 
the word in the object or table. You might select this button, for instance, if you 
misspelled a company name several times in a column. 
 
If the list of possible alternative spellings in the Suggestions list box does not contain 
the correct spelling, you can type the correct spelling directly into the Spelling dialog 
box and then change the single occurrence or all occurrences of the word in the object 
or table. 
 
Since the spelling checker identifies words not in the main dictionary, it questions 
many names, abbreviations, and technical terms. Examples of these terms might 
include a product or company name, an acronym, or a city. When a word is spelled 
correctly, you can either disregard this occurrence of the identified word by selecting 
the Ignore button or all occurrences of the word by selecting the Ignore All button. If 
a word is correct, you can also use the Add button to add it to your custom dictionary. 
 
If you make a mistake during a spell check you can use the Undo Last button in the 
Spelling dialog box to reverse any changes you make. The Undo Last button can 
reverse multiple spelling actions one at a time, working backward from the previous 
action. 
 
Access informs you when it has finished spell checking the selection. It will either 
open a message box where you have to select OK or, if the Office Assistant is open, it 
announces that the spell check is complete. 
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When using the Spelling Checker in a table, you have the 
option of ignoring certain fields. This option is useful for 
fields containing names of people or obscure text. 

  

 
You can also activate the spelling checker by selecting the 
Tools menu and then selecting the Spelling command. 

  

 
You can also reverse any changes you make during a spell 
check by clicking in the table and using the Undo feature from 
either the Form View or Report View toolbar or the Edit 
menu.  

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the columns you want to spell check. 

4. Select the Spelling button  on the Form View or Report View 
toolbar. 

5. To change the spelling of an identified word, select the desired 
spelling for the identified word from the Suggestions list box. 

6. Select Change or Change All. 

7. To ignore an identified word, select Ignore or Ignore All, as desired. 

8. To add an identified word to the custom dictionary, select Add. 

9. To edit an identified word, type the correct spelling of the identified 
word in the Change To text box. 

10. Select Change or Change All as desired. 

11. To reverse an action, select Undo Last. 

12. To end a spell check before it is completed, select Close. 

13. If prompted, select OK to end a spell check when it is complete. 
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SETTING AUTOCORRECT OPTIONS 

 Discussion 
Access provides a tool called AutoCorrect that corrects misspelled words and expands 
abbreviations that are defined in the AutoCorrect dictionary. For example, you can 
add commonly typed mistakes such as “teh” and “adn” to the AutoCorrect dictionary 
and have them replaced with “the” and “and” automatically whenever they are typed. 
You can also add an abbreviation to be expanded to save time typing. For example, if 
you type the “United States of America” often, you can add “USA” to the dictionary 
and define its replacement as the lengthier version. 
 
AutoCorrect also has options available to make such text changes as correcting words 
with two initial capitals (EXample), capitalizing days of the week, and replacing text 
as you type. 
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the Tools menu. 

4. Select the AutoCorrect command. 

5. Select or deselect the desired options. 

6. Select OK. 

 

ADDING AUTOCORRECT ENTRIES 

 Discussion 
To use AutoCorrect to its full potential, it is a good idea to add the typing mistakes 
you make most often and the correct replacements to the AutoCorrect dictionary. You 
can also add abbreviations for commonly typed text. For example, you can add initials 
and the corresponding full name to the dictionary so that when you type JAD, 
AutoCorrect replaces it with John Alan Doe. 
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Adding an AutoCorrect entry 

 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the Tools menu. 

4. Select the AutoCorrect command. 

5. Type the text you want to replace in the Replace text box. 

6. Press [Tab]. 

7. Type the replacement text in the With text box. 

8. Select Add. 

9. Select OK. 
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DELETING AUTOCORRECT ENTRIES 

 Discussion 
At times, you may find that certain entries in the AutoCorrect dictionary are not 
necessary. These entries can easily be removed from the dictionary. For example, if 
the AutoCorrect dictionary contains initials of an employee who has left the company, 
you would want to remove those initials from the dictionary. 
 

  

 
To quickly find an entry in the AutoCorrect dictionary, you 
can type the first few letters of the entry in the Replace text 
box. The list box scrolls automatically to the entry. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the Tools menu. 

4. Select the AutoCorrect command. 

5. Select the entry you want to delete from the list box. 

6. Select Delete. 

7. Select OK. 

 



 

 

LESSON 10 -  
PRINTING DATA  

In this lesson, you will learn how to: 

• Print table data  

• Change the page setup  

• Print selected records  
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PRINTING TABLE DATA 

 Discussion 
If you want to print all the data in a table, you can use either Database or Datasheet 
view. Access uses the default settings for the printer. If there are too many fields to fit 
on the width of one page, Access prints as many fields as possible that can fit on the 
first page and then prints the next set of fields for the same records on the next page, 
until all the fields have been printed. The following page then starts with the next set 
of records. 
 

  

 
The Print button is a quick way to get a printout of your data. 
However, this method is best used for smaller tables since it 
leaves you with very little control over the print job. You 
could end up using a lot of paper and printer time if you have 
a large table. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Click the Print button  on the Table Datasheet toolbar. 

 

CHANGING THE PAGE SETUP 

 Discussion 
You can control the way a job prints by changing the page setup. This option allows 
you to adjust the margins and change the paper orientation so that more data can fit on 
fewer pages. 
 
The Page Setup dialog box has two tabbed pages. On the Margins page, you can 
change the default one inch margins and choose to print without the column headings. 
A preview of your margin changes appears in the Sample box. On the Page page, you 
can change the paper orientation from the default of portrait (the shorter edge of the 
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page at the top) to landscape (the longer edge of the page at the top). You can also 
choose a different paper size, paper source, and printer. 

 
The Page Setup dialog box 

 
  

 
You can also access the Page Setup dialog box by selecting 
the Setup button in the Print dialog box. 

  
 

 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the File menu. 

4. Select the Page Setup command. 

5. Change the margin measurements as desired. 

6. Select the Page tab. 

7. Select options as desired. 
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8. Select OK. 

 

PRINTING SELECTED RECORDS 

 Discussion 
If you do not need the entire table of information, you can choose to print only 
selected records. You must print selected records using the Print dialog box so that 
you can select the desired print range option. 

 
The Print dialog box 

 
  

 
To print selected records, the records must be adjacent. 

  

 
You can also change other options in the Print dialog box, 
such as selecting the number of copies or the specific pages to 
print. 

  

 
You can also select multiple records by selecting the first 
record, pressing the [Shift] key, and clicking the last record in 
the group. 
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 Steps 

1. Open the desired database. 

2. Open the desired table in Datasheet view. 

3. Select the record(s) you want to print. 

4. Select the File menu. 

5. Select the Print command. 

6. Select the Selected Record(s) option under Print Range. 

7. Select OK. 

 





 

 

LESSON 11 -  
USING ADVANCED DATABASE FEATURES  

In this lesson, you will learn how to: 

• Print a relationship document  

• Link data to an Access table  

• Import data  

• Set a database password  

• Compact a database  

• Back up a database  
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PRINTING A RELATIONSHIP DOCUMENT 

 Discussion 
It is a good idea to document your database structure and relationships. The 
Documenter feature in Access allows you to view, print, and save the design 
characteristics of database objects. You can view and print such information as the 
properties associated with tables, queries, forms, and reports. This type of information 
is very useful for deciding what changes you want to make or when you have to 
maintain a database that was developed by someone else. 
 
While the Relationship window provides a good way to view table relationships, as 
well as join lines and types, you cannot print the view. The Documenter feature 
allows you to print out all the relationships between tables in your database. The 
relationship report that the Documenter feature produces provides information on the 
tables involved, the attributes, and the type of relationship, which, in turn, provides 
you with all the information you need to analyze your database table relationships. 

 
The Documenter dialog box 

 
  

 
The Documenter feature is not included in the default 
installation. You can choose to install it with the initial 
installation, or it can be installed by itself at a later time. 

  

 
You can also open the Documenter dialog box by selecting the 
arrow on the Analyze button on the Database toolbar and 
then selecting the Documenter command. 
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 Steps 

1. Open the desired database. 

2. Select the Tools menu. 

3. Point to the Analyze command. 

4. Select the Documenter command. 

5. Select the Current Database tab. 

6. Select the Relationships option. 

7. Select OK. 

8. Click the Print button  on the Print Preview toolbar. 

 

LINKING DATA TO AN ACCESS TABLE 

 Discussion 
You can link to an external data source, such as another Access database or another 
program (e.g., dBASE or Excel). You can also link to HTML data tables on a network 
server or the Internet. When you link to an external data source, the format of the data 
in the data source does not change. You can use Access to add, edit, or delete the data. 
 
A linked table is represented by a different icon in the Database window. A table 
linked to another Access table has an arrow to the left of the icon. A table linked to a 
source from another program has an arrow and the initials of the source program (e.g., 
Px for Paradox) to the left of the icon. 
 
Linking tables is useful when you want to share data on a network. If you link to a 
table on a network, the link updates the data so that you are always working with the 
latest available data. 
 

  

 
When you delete a linked table, you delete the icon and the 
link to the source table. You do not delete the source table 
itself. 

  

 
You can also open the Link dialog box by right-clicking in the 
Database window and then selecting the Link Tables 
command. 
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 Steps 

1. Open the desired database. 

2. Select the File menu. 

3. Point to the Get External Data command. 

4. Select the Link Tables command. 

5. Select the Look in list. 

6. Select the drive where the source data is stored. 

7. Select the folder where the source data is stored. 

8. Select the file containing the source data. 

9. Select Link. 

10. Select the table containing the source data. 

11. Select OK. 

 

IMPORTING DATA 

 Discussion 
You can import data from several external data sources. The external data source can 
be another Access database, another program, such as dBASE or Excel, ASCII text, or 
an HTML data table. When you import data from a spreadsheet, another type of 
database or ASCII text, a wizard opens to step you through the process. The format of 
the data in the external data source does not change. You can use Access to add, edit, 
or delete the data. 
 
If the external data source is an Access database, you can also import database objects 
such as queries, reports, and forms. This option allows you to copy a query from one 
database to another and modify it as necessary, rather than creating a new one. In 
addition, this option allows you to easily copy standard reports and forms between 
databases. 
 

  

 
If the table you import has a lookup field, you should also 
import the source of the information for the lookup field. 

  

 
You can select the Options button in the Import Objects 
dialog box to display the import options. 
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You can also open the Import dialog box by right-clicking in 
the Database window and then selecting the Import 
command. 

  
 

 Steps 

1. Open the desired database. 

2. Select the File menu. 

3. Point to the Get External Data command. 

4. Select the Import command. 

5. Select the Files of type list. 

6. Select the file type corresponding to the file containing the source of 
data. 

7. Select the Look in list. 

8. Select the drive where the source data is stored. 

9. Select the folder where the source data is stored. 

10. Select the file containing the source data. 

11. Select Import. 

12. Select the appropriate format option. 

13. Select Next. 

14. Select the desired delimiter option. 

15. Select the First Row Contains Field Names option, if applicable. 

16. Select Next. 

17. Indicate whether the data is to be stored in a new table or an existing 
table. 

18. Select the desired options or Next to accept the default selections. 

19. Select the desired primary key option. 

20. Select the desired options or Next to accept the default selections. 

21. Enter the desired name for the table. 

22. Select Finish. 

23. Select OK. 
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SETTING A DATABASE PASSWORD 

 Discussion 
You can secure a database by setting a password. Once a password is set, you must 
enter the password before you can open the file. Once the file is open, all the database 
objects are available. 
 
Passwords are case-sensitive. You must type them exactly how they were originally 
entered or the file will not open. 

 
The Set Database Password dialog box 

 
  

 
Another way to protect the contents of a database is to encrypt 
the database. Once a database has been encrypted, other 
programs such as utilities, text editors, and word processors 
cannot read it. Encrypting a database does not limit what you 
can do with the database in Access. Decrypting a database 
removes the encryption. To encrypt or decrypt a database, 
select the Tools menu, point to the Security command, and 
then select the Encrypt/Decrypt Database command. 

  

 
You cannot set a password unless you have exclusive use of 
the database. You must reopen the database with the 
Exclusive option set. If the database is on a network, other 
users must close it, or you will not be able to open it 
exclusively. 

  
 

  

 
If you forget the password, you will not be able to access the 
file. There is no way to retrieve a password. 
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 Steps 

1. Open the desired database. 

2. Select the File menu. 

3. Select the Open command. 

4. Select the Look in list. 

5. Select the drive where the source data is stored. 

6. Select the folder where the source data is stored. 

7. Select the file for which you want to set a password. 

8. Select the Open list. 

9. Select Open Exclusive. 

10. Select the Tools menu. 

11. Point to the Security command. 

12. Select the Set Database Password command. 

13. Type the desired password. 

14. Press [Tab]. 

15. Retype the password. 

16. Select OK. 

 

COMPACTING A DATABASE 

 Discussion 
If you delete tables and other objects in a database, the database size on the disk does 
not necessarily decrease. Therefore, Access has a utility that compacts a database. 
This utility defragments the file and releases storage space. 
 
If you specify a different name or location for a compacted database, you create a 
copy of the original database. The database must be closed in order to make a copy. 
You can compact the current database while it is open. 
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 Steps 

1. Open the database you want to compact. 

2. Select the Tools menu. 

3. Point to the Database Utilities command. 

4. Select the Compact and Repair Database command. 

 

BACKING UP A DATABASE 

 Discussion 
It is important to backup your database on a regular basis. Since most databases are 
too large to fit on a floppy disk, you need to have a means to make a backup. 
Normally, databases are shared and are located on a network server. Most companies 
have a backup process to ensure that all data is saved to tape or some other media at 
least once a day. If your database is kept on the hard drive of a personal computer, the 
contents of that hard drive needs to be saved to another drive or removable media, 
such as a tape or a CD to which you can write, such as a CD-R. Saving the database 
this way ensures that all queries, forms, and reports you have created are saved, as 
well as the data that has been entered. As a result, you can recover your database in 
the event that something would happen to your database. 
 
If none of the above options are available, you can export individual components, 
tables, queries, forms, etc. to a floppy disk. In addition, you can save the data as 
ASCII text, or as Excel tables. However, you cannot save queries, forms, and reports 
using this method. 
 



 

 

LESSON 12 -  
WORKING WITH THE OFFICE ASSISTANT  

In this lesson, you will learn how to: 

• Use the Office Assistant  

• Find an answer  

• Hide/Display the Office Assistant  
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USING THE OFFICE ASSISTANT 

 Discussion 
To assist you in quickly and efficiently getting comprehensive help on any Access 
feature, you can use the Office Assistant. The Office Assistant appears in the 
application window as an animated graphic with a balloon attached. The balloon 
contains shortcuts for accessing additional topics and tips. When you display the 
Office Assistant, the balloon automatically appears. In addition, the Office Assistant 
automatically provides tips and help on tasks as you work. The Office Assistant 
moves when it is in the way. 
 
The Office Assistant provides helpful hints called tips to help you get the most from 
Access. A typical tip might provide a keyboard combination that quickly displays a 
particular dialog box or a more efficient way to accomplish a task. You can click the 
Microsoft Access Help button to open the Office Assistant and view the tip. 
 
After you have read the tip, you can close it; however, tips are not available for all 
Access objects. In addition, if the topic you are looking for does not appear, you can 
ask for more help from the Web. 

 
The Office Assistant 
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If the Office Assistant is not displayed, you can activate it by 
selecting the Help menu and then selecting the Show the 
Office Assistant command. 

  

 
Once you have closed a tip, it does not appear again. To view 
a previous tip, you can select the Reset my tips button on the 
Options page in the Office Assistant dialog box. 

  
 

 Steps 

1. Click the light bulb that appears next to the Office Assistant. 

2. When you have finished viewing the tip, select OK. 

 

FINDING AN ANSWER 

 Discussion 
You can query the Office Assistant directly with any questions you may have 
regarding Access. When you query the Office Assistant, help topics related to your 
question appear. You can select any available help topic to view additional 
information. If there are more topics than can be displayed at one time, you can use 
the See more and the See previous commands to scroll through the available topics.  
 
The Office Assistant provides the best answers when you enter a complete sentence or 
question in a query, rather than just a word or phrase. For example, it is better to enter 
How do I open a form? rather than just forms. The last query remains in the Office 
Assistant until you create a new query or exit Access. 
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Finding an answer to a question 

 

 Steps 

1. Open the Office Assistant. 

2. Click the Office Assistant. 

3. Type the desired question or sentence. 

4. Select Search. 

5. Select the desired help topic. 

6. Click the Close button on the help window title bar. 

 

HIDING/DISPLAYING THE OFFICE ASSISTANT 

 Discussion 
You can display or hide the Office Assistant as desired. Hiding the Office Assistant 
removes it from view, but does not disable it. The Office Assistant continues to 
monitor your activities and, if it detects that you are using procedures that can be 
performed more efficiently, the Office Assistant button on the toolbar displays a light 
bulb, or it may appear automatically to offer assistance. 



Creating Tables Using Access 2000 Lesson 12 - Working with the Office Assistant 

US Senate Office of Education and Training Page 111
 

 
You may want to hide the Office Assistant if you are not using it, find it distracting, or 
require a larger working area. 
 

  

 
You can also hide the Office Assistant by clicking it with the 
right mouse button and selecting the Hide command. You can 
also permanently disable the Office Assistant by deselecting 
the Use the Office Assistant option in the Office Assistant 
dialog box. 

  

 
If the Office Assistant is enabled, but hidden, you can click the 
Microsoft Access Help button on the default toolbar to 
display it. 

   
 

 Steps 

1. Open the Office Assistant. 

2. Close the Microsoft Access dialog box. 

3. Select the Help menu. 

4. Select the Hide the Office Assistant or Show the Office Assistant 
command. 

 





 

 

LESSON 13 -  
USING ONLINE HELP  

In this lesson, you will learn how to: 

• Work with online Help  

• View ScreenTips  

• Use Help Contents  

• Show and hide the help tabs  

• Use the Help Answer Wizard  

• Use the Help Index  
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WORKING WITH ONLINE HELP 

 Discussion 
If you need assistance on any Access topic or task, you can use Access’ extensive 
Help facility. There are several ways in which you can get help, all of which are 
available from the Help menu. One way is using the Microsoft Access Help 
command, which launches the Office Assistant if it is enabled. If the Office Assistant 
is disabled, you can directly access the Help window, which includes the Contents, 
Index, or Answer Wizard components. These components allow you to scroll through 
a table of contents, search for a specific word or phrase based on a keyword, or search 
based on a question you type. 
 
The What’s This? command can be used to display a ScreenTip. Pressing the [F1] 
key invokes context-sensitive Help. 
 
If you have World Wide Web access on the Internet, you can use the Office on the 
Web submenu to connect to web sites directly from Access. You can download free 
programs, access on-line support, and get the latest Microsoft product information 
from a web siteall without leaving Access. 
 
The Detect and Repair command reviews the previous install process and finds and 
fixes problems that may have developed during or since the initial software 
installation. The Detect and Repair feature cannot repair corrupted data files. 
 
You can use the About Microsoft Access command to view copyright and licensing 
information about the program. The About Microsoft Access window contains a 
System Info button that displays information about your computer and a Tech 
Support button that provides help on getting product support. 
 

  

 
You can disable the Office Assistant by deselecting the Use 
the Office Assistant option on the Options page in the Office 
Assistant dialog box. 

  
 

VIEWING SCREENTIPS 

 Discussion 
If you are unsure of the name and function of a menu command or any other item in a 
window, you can use a ScreenTip to view either the item name or a description of the 
item. You can access ScreenTips by selecting the What’s This? command from the 
Help menu. 
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ScreenTips for toolbars are activated by default, as long as you have enabled the 
option in the Customize dialog box. To view a ScreenTip for a toolbar button, you 
point to the desired toolbar button and the button name appears. 
 
When ScreenTips are activated, the mouse pointer appears with a question mark. 
 

  

 
You can also access ScreenTips by pressing the [Shift+F1] 
key combination and then pointing to and/or clicking the item 
for which you want help. 

  
 

 Steps 

1. Select the Help menu. 

2. Select the What’s This? command. 

3. Point to the button or item with which you want help. 

4. Click the button or item with which you want help. 

 

USING HELP CONTENTS 

 Discussion 
The Microsoft Access Help window, accessible from the Microsoft Access Help 
command on the Help menu when the Office Assistant is disabled, is comprised of 
two panes. The pane on the left contains the three help tabs: Contents, Answer 
Wizard, and Index. The pane on the right contains the information pertaining to the 
selected help topic. 
 
The Contents page displays a list of general help topics. From this list, you can select 
a help topic for a particular group of features or functions. This page is structured like 
a standard table of contents. The table is expandable; when you double-click a topic, 
related subtopics appear. When you select the help topic you want to view, it appears 
in the right pane of the help window. The underlined, colored text that appears in the 
right pane may be selected to display additional help topics. 
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Using Help Contents 

 
  

 
You can also expand help topics on the Contents page by 
clicking the plus sign (+) next to the desired topic. 

  
 

 Steps 

1. Disable the Office Assistant on the Options page in the Office 
Assistant dialog box, if necessary. 

2. Select the Help menu. 

3. Select the Microsoft Access Help command. 

4. Select the Contents tab. 

5. Select the desired topic. 

6. Select the desired subtopic. 
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SHOWING AND HIDING THE HELP TABS 

 Discussion 
When the Microsoft Access Help window is opened from the Help menu, it displays 
two panes: the tabs for the help components appear in the left pane and the 
information about the selected help topic appears in the right pane. 
 
You can hide the left pane or show both panes of the Microsoft Access Help window 
using the Show and Hide buttons at the top of the window. Hiding the help tabs in the 
left pane decreases the size of the help window. This option allows you to continue 
working in the Database window while you reference the selected help topic text in 
the right pane of the Microsoft Access Help window. 
 

  

 
When you select a help topic using the Office Assistant, only 
the right pane of the Microsoft Access Help window appears. 
You must use the Show button to access the Contents, 
Answer Wizard, and Index tabs. 

  

 
You can also show or hide the help tabs by selecting the Show 
Tabs or Hide Tabs commands from the Options button in the 
Microsoft Access Help window. 

  
 

 Steps 

1. Open the Microsoft Access Help window. 

2. Click the Hide button  at the top of the Microsoft Access Help 
window to hide the help tabs in the left pane. 

3. Click the Show button  at the top of the Microsoft Access Help 
window to display the help tabs in the left pane. 
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USING THE HELP ANSWER WIZARD 

 Discussion 
You can use the Answer Wizard page in the Microsoft Access Help window to 
quickly locate help topics based on questions you ask. The Answer Wizard page 
functions in much the same way as the Office Assistant. Any help topics that satisfy 
the typed question appear when you search using the Answer Wizard.  

 
Using the Help Answer Wizard 

 

 Steps 

1. Disable the Office Assistant on the Options page in the Office 
Assistant dialog box, if necessary. 

2. Select the Help menu. 
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3. Select the Microsoft Access Help command. 

4. Select the Answer Wizard tab. 

5. Type the question on which you want to base your search in the 
What would you like to do? text box. 

6. Select Search. 

7. Select the desired help topic in the Select topic to display list box. 

 

USING THE HELP INDEX 

 Discussion 
The Access Help system includes an alphabetical index of available help topics on the 
Index page in the Microsoft Access Help window. 
 
The Index page enables you to search for a topic using a keyword. When the keyword 
is typed into the Type keywords text box, an alphabetical index of available help 
topics appears. You then select the desired topic which then displays an additional list 
of subtopics. 
 
When entering search criteria containing more than one word, place an underline 
character between each word. For example, to search for a subject such as page 
break, you would type page_break in the Type keywords text box. 



Lesson 13 - Using Online Help Creating Tables Using Access 2000 

Page 120 US Senate Office of Education and Training
 

 
Using the Help Index 

 
  

 
If you want to perform another search on a different subject, 
select the Clear button to clear the previous search criteria and 
then enter the new search criteria. 

  
 

 Steps 

1. Disable the Office Assistant on the Options page in the Office 
Assistant dialog box, if necessary. 

2. Select the Help menu. 

3. Select the Microsoft Access Help command. 

4. Select the Index tab. 

5. Type the topic for which you want to search. 
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6. Select Search to search for the keyword(s) or double-click a topic 
from the Or choose keywords list box. 

7. Double-click the desired subtopic in the Choose a topic list box. 
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Access 

exiting, 12 
starting, 3, 4 

AutoCorrect 
adding entries, 90, 91 
deleting entries, 92 
setting options, 90 

Cell effects 
changing, 54, 55 

Column width 
changing, 52, 53 

Columns 
changing the name, 73 
deleting, 74 
freezing, 58 
hiding, 56, 57 
hyperlink, 77 
inserting in a table, 72, 73 
lookup, 75, 76 
moving, 56 
selecting, 55 
unhiding, 57, 58 

Data 
importing, 102, 103 
linking to a table, 101, 102 
replacing, 63, 64 

Data types 
assigning, 18, 20 

Database objects 
importing, 102, 103 
opening, 11, 12 
types, 9 

Database window 
using, 10 

Databases 
backing up, 106 
compacting, 105, 106 
creating new, 14 
designing relational, 2 
forms, 9 
macros, 9 
modules, 9 
opening an existing, 4, 5 
queries, 9 
reports, 9 
tables, 9 
using, 2 
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using objects, 9 
Datasheet view 

using, 28 
Date/Time formats 

setting, 42, 43 
Default values 

setting, 45 
Design view 

using, 17 
Documenter 

using, 100, 101 
Editing tools 

adding AutoCorrect entries, 90, 91 
deleting AutoCorrect entries, 92 
running the spelling checker, 88, 89 
setting AutoCorrect options, 90 

Exiting 
Access, 12 

Field descriptions 
adding, 21 

Field names 
adding, 17, 18 

Field properties 
creating an input mask, 47, 49 
limiting the field size, 39, 40 
property types, 38 
setting date/time formats, 42, 43 
setting default values, 45 
setting number formats, 41, 42 
setting validation rules/text, 46, 47 
setting yes/no formats, 44 
using, 38 

Field size 
limiting, 39, 40 

Fields, 2 
navigating in tables, 28 

Filter By Form 
using, 69, 70 

Filter By Selection 
using, 65, 66 

Filter Excluding Selection 
using, 67 

Filter For 
using, 67, 68 

Filters 
applying/removing, 66, 67 
Filter By Form, 69, 70 
Filter By Selection, 65, 66 
Filter Excluding Selection, 67 
Filter For, 67, 68 

Finding 
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specific records, 61 
using wildcards, 62, 63 

Font 
changing attributes, 53, 54 

Forms, 9 
Help 

hiding the tabs, 117 
showing the tabs, 117 
using Contents, 115, 116 
using the Answer Wizard, 118 
using the Index, 119, 120 
viewing ScreenTips, 114, 115 
working with, 114 

Hyperlink columns 
inserting, 77 

Input mask 
creating, 47, 49 

Lookup columns 
inserting, 75, 76 

Lookup Wizard, 75 
Macros, 9 
Menu commands 

using, 5, 6 
Menus 

changing options, 8 
Modules, 9 
Number formats 

setting, 41, 42 
Object types 

selecting, 11 
Office Assistant 

displaying, 110, 111 
finding an answer, 109, 110 
hiding, 110, 111 
using, 108, 109 

Page setup 
changing, 94, 95 

Passwords 
setting, 104, 105 

Primary key 
setting, 22 

Printing 
changing the page setup, 94, 95 
selected records, 96, 97 
table data, 94 

Queries, 9 
Records, 2 

adding, 29, 30 
deleting, 35 
editing, 32, 34 
finding specific, 61 
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moving through, 30, 31 
printing selected, 96, 97 
replacing data, 63, 64 
saving, 34 
selecting, 31, 32 
sorting, 60 

Relationship documents 
printing, 100, 101 

Relationships 
adding a table to the Relationships window, 85, 86 
creating, 80, 81 
creating many-to-many, 83, 84 
one-to-many, 80 
one-to-one, 80 
setting referential integrity, 82, 83 
using related tables, 80 

Relationships window, 80, 81 
adding a table, 85, 86 

Replace 
using, 63, 64 

Reports, 9 
Row height 

changing, 52 
Saving 

tables, 23 
ScreenTips 

viewing, 114, 115 
Spelling checker 

correcting words, 88, 89 
running, 88, 89 

Table Wizard 
using, 23, 25 

Tables, 2, 9 
adding field descriptions, 21 
adding field names, 17, 18 
adding records, 29, 30 
adding to the Relationships window, 85, 86 
assigning data types, 18, 20 
changing a column name, 73 
changing cell effects, 54, 55 
changing column width, 52, 53 
changing font attributes, 53, 54 
changing row height, 52 
creating in Design view, 16, 17 
deleting a column, 74 
deleting records, 35 
designing, 15 
editing records, 32, 34 
freezing columns, 58 
hiding columns, 56, 57 
inserting a column, 72, 73 
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inserting a hyperlink column, 77 
inserting a lookup column, 75, 76 
linking, 101 
linking data, 101, 102 
moving columns, 56 
moving through records, 30, 31 
navigating fields, 28 
printing data, 94 
related, 80 
relating, 2 
saving new, 23 
saving records, 34 
selecting columns, 55 
selecting records, 31, 32 
setting a primary key, 22 
unhiding columns, 57, 58 
using Datasheet view, 28 
using Design view, 17 
using the Table Wizard, 23, 25 

Toolbars 
changing options, 8 
displaying, 7, 8 
hiding, 7, 8 

Validation rules/text 
setting, 46, 47 

Wildcards 
using, 62, 63 

Yes/No formats 
setting, 44 
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please visit the Education and Training web site at: 

webster/saa/services/training 
or 

Call the Education and Training registration number at: 
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